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2 Disclaimer 

The actual version of this product (document) is available as is. TEC-IT declines all warranties which 
go beyond applicable rights. The licensee (or reader) bears all risks that might take place during the 
use of the system (the documentation). TEC-IT and its contractual partners cannot be penalized for 
direct and indirect damages or losses (this includes non-restrictive, damages through loss of 
revenues, constriction in the exercise of business, loss of business information or any kind of 
commercial loss), which is caused by use or inability to use the product (documentation), even if TEC-
IT has been advised of or TEC-IT has pointed out the possibility of such damages.  

 

 
We reserve all rights to this document and the information contained therein. Reproduction, 
use or disclosure to third parties without express authority is strictly forbidden. 
 

 Für dieses Dokument und den darin dargestellten Gegenstand behalten wir uns alle 
Rechte vor. Vervielfältigung, Bekanntgabe an Dritte oder Verwendung außerhalb des 
vereinbarten Zweckes sind nicht gestattet. 
 

© 1998-2022  
TEC-IT Datenverarbeitung GmbH  
Hans-Wagner-Str. 6 

A-4400 Austria  
t.: +43 (0)7252 72720  
f.: +43 (0)7252 72720 77  
www.tec-it.com 

 

https://www.tec-it.com/
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3 Introduction 

3.1 About 

TEC-IT Barcode Studio is a tool for generating and printing barcodes.  

Barcode Studio creates more than 100 different barcode symbologies: linear, 2D, postal and GS1 
composite barcodes are supported. All barcode parameters are adjustable. The barcodes are created 
as image files (e.g. for using it in your artwork), as high quality vector images (for graphics design or 
pre-press applications), copied to the clipboard or printed directly with any printer. Batch barcode 
generation with external or manual entered data is also supported. 

If you have any questions, please contact us. 

Address: Hans-Wagner-Str. 6  

AT-4400 Steyr  

Austria/Europe 

Phone: +43 / (0)7252 / 72 72 0 

Fax: +43 / (0)7252 / 72 72 0 – 77 

Email: office@tec-it.com 

Web: www.tec-it.com 

3.2 Supported Operating Systems 

 Mac OS (10.14 or higher) for Intel 

 Windows 10 

 Windows 8.1 

 Windows 7 

 Windows Server 2019 

 Windows Server 2016 

 Windows Server 2012 and 2012 R2 

 Windows Server 2008 and 2008 R2 

 Linux/UNIX (please refer to www.tec-it.com or request a build) 

3.3 Restrictions of the Demo Version 

► A demo marker across the barcode indicates that the demo version is active. The correctness 
of the barcode is not affected. 

► To obtain a license key for the full version (without the demo marker) please order Barcode 
Studio online at www.tec-it.com/order/default.aspx. 

 

mailto:office@tec-it.com
https://www.tec-it.com/
https://www.tec-it.com/
https://www.tec-it.com/order/default.aspx


 
 
 

Page 9 of 86 

 

Barcode Studio User Manual  

4 Installation 

4.1 Install Barcode Studio on Microsoft® Windows 

On Microsoft® Windows operating systems (Windows8, Windows7, Vista, etc.), Barcode Studio is 
installed with the Windows Installer. If the Windows Installer is not available on the system, please 
download it from the following link: 

https://www.microsoft.com/downloads/details.aspx?FamilyID=889482fc-5f56-4a38-b838-

de776fd4138c&displaylang=en 

Please follow the steps as outlined below (administrator privileges are required). 

1. Open the installer by double-clicking it. 

2. Follow the instructions in the installation wizard. 

By default, Barcode Studio is installed in the following directories: 

C:\Program Files\TEC-IT\BCStudio16   (binary files + documentation) 

C:\ProgramData\TEC-IT\BCStudio\16.4  (templates, option file, etc.) 

4.2 Install Barcode Studio on Mac OS X® (10.14 or higher) 

For Mac operating systems (Mac OS X 10.14 or higher), Barcode Studio is provided as a zipped 
pkg-file. 

Please follow the steps as outlined below. 

1. Open the zip-file by double-clicking it. 

2. Open the contained pkg-file also by double-clicking it. 

3. Follow the instructions of the setup wizard. 

https://www.microsoft.com/downloads/details.aspx?FamilyID=889482fc-5f56-4a38-b838-de776fd4138c&displaylang=en
https://www.microsoft.com/downloads/details.aspx?FamilyID=889482fc-5f56-4a38-b838-de776fd4138c&displaylang=en
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5 Quick-Start 

5.1 Introduction 

This chapter will guide you through the most important functions of Barcode Studio by showing you 
how to create an EAN13 barcode. For more detailed explanation of the user interface and the 
available functions and settings, please refer to the chapters 6 to 10. 

► Starting with Barcode Studio version 11 pre-defined barcode templates are available. The 
creation of standardized barcodes is simplified dramatically (see section 5.3).  

5.2 How to Create an EAN13 Barcode 

 
Figure 1: Quick-Start – Barcode Studio Main Window 

In order to create an EAN13 barcode, please follow these steps: 

Select the barcode type (symbology) – see section 5.2.1. 

Enter the barcode data – see section 5.2.2. 

Select the output resolution – see section 5.2.3. 

 Specify the barcode dimensions – see section 5.2.4. 

 Fine-tune the module width – see section 5.2.5. 

 Set font style and size – see section 5.2.6. 

 Export or print the barcode – see section.5.4. 

















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5.2.1 Select Barcode Type (Symbology) 

  
 

Select the required barcode type (symbology) in . Choose 
“EAN 13”. 

Hint: If you press the E key, the first entry starting with an “E” 
will be selected. 

 

5.2.2 Enter Barcode Data 

The EAN13 barcode needs exactly 12 digits (or 13 digits including the check digit). By default you will 
see the sample data “123456789012” if the checkbox “Example Data” is checked. 

 

 
 

Enter the data to be encoded in . Alternatively you can also 
use the Data Input Assistant (see 7.7.1.1). 

  

 

The barcode view is updated after every change. The barcode 
cannot be drawn before you have entered the required twelve 
(or thirteen) digits. 

If “Example Data” is not checked, the current input data may be invalid for the selected barcode (e.g. 
wrong characters or a wrong number of characters). In this case you will see an error message like 
the following: 

Error: Wrong number of input characters (12 chars needed)! 

For a list of the most common error messages, please refer to Appendix B. 

► The 13th digit in the resulting EAN13 barcode (in this case the digit “3”) is the check digit. It will 
be calculated automatically. 

► If you enter 13 instead of 12 characters you need to provide the correct check digit yourself. 
This is not recommended. A wrong check digit may make the barcode unreadable! 




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5.2.3 Select Output Resolution 

► Barcode Studio uses the selected resolution for computing the barcode images. Thus it is 
essential to adjust a resolution which leads to readable barcodes (see also section 5.2.5).   

► Usually higher resolutions lead to a better barcode quality. However, at the same time it is 
important that the selected resolution accords to the resolution of the output device (or of the 
image processing software). 

 

 

The output resolution can be adjusted in .  

 

In this example the output resolution is changed to 
“300 dpi”. If you are planning to print the barcode 
on a laser printer you would most probably select 
a higher resolution (600 or 1200 dpi). 

If you want to export the barcode as image for 
your web page you could also choose “Screen 
Resolution” or “72 dpi (BMP)”.  

 

► If you use barcode images in pre-press applications, please take care to avoid any scaling or 
resizing of the generated barcode image. This may lead to inaccuracies and distortions 
rendering the barcode unusable. Generate the barcode image in exactly the resolution and 
size as required! 

5.2.4 Specify Barcode Dimensions 

The barcode dimensions can be modified by changing width, height, and module width. 

Most label or barcode specifications require specific barcode dimensions. The following values are 
commonly used for EAN13: 

Magnification factor Module width [mm] Width [mm] Height [mm] 

0.80 0.264 (SC0) 29.83 20.73 

1.00 0.330 (SC2) 37.29 25.91 

1.50 0.495 (SC6) 55.94 38.87 

2.00 0.660 (SC9) 74.58 51.82 

Table 1: EAN13 Dimensions (not complete) 

 
 

In this example we use the magnification 
factor 1.00. 

 

Enter the width and the height in . The 
appropriate module width will be calculated 
automatically. 

 




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The barcode now looks like this: 

 

5.2.5 Fine-tune the Module Width 

Look if the quality of the barcode is not perfect yet (see the Quality Watch at the top right corner of 
the Barcode Studio application window): 

 

To optimize the barcode quality we recommend fine-tuning the module width. You have the following 
possibilities to do so: 

 Select the option “Optimize” (see Figure 1, ). 

 Choose the unit “Pixel” and enter a whole-numbered value in the field “Module Width”. 

 Increase the output resolution. 

The first two options both lead to a perfect barcode quality. 

5.2.6 Set Font Style and Size 

The font properties are set via the “Select Font” dialog. You can open this dialog by clicking the  
button in the “Text Placement” section (see Figure 1 ). 

This example uses a 10 pt. Courier New font: 
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5.3 Barcode Templates 

The list of barcode templates contains a selection of frequently used barcode types including their 
default settings.  

► The templates which are part of the Barcode Studio installation comply with various bar 
coding standards. By using these templates you create optimal barcodes and you save time 
for an optional certification of the barcode. 

In order to create an EAN 13 barcode with default settings please perform following steps: 

Go to the templates list. 

Select the entry “EAN 13 / SC2 (100%)…” 

Enter the barcode data – see section 5.2.2. 

 Adjust any other settings if needed. 

 Export or print the barcode – see section.5.4. 

 

  
Figure 2: Quick-Start with Templates – Barcode Studio Main Window 












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5.4 Export or Print the Barcode 

The barcode can be used in the following ways: 

 Export to clipboard: 
The clipboard allows you to quickly insert the barcode into any application like Microsoft 
Word or Microsoft Excel using the keyboard shortcut Ctrl+V. 

 File export: 
The file export creates an image file. Different bitmap and vector formats are supported. 

 List export: 
In order to export multiple barcodes at once use the data list (see chapter 8). You can either 
use the barcode data or a sequential number as file names. 

 Print: 
With the print command you can print barcode labels (see chapter 9). 

For further information on the barcode export, please refer to chapter 6. The data list and the label 
printing are explained in the chapters 8 and 9. 
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6 Using Barcodes in Applications  
(Exporting Barcodes) 

This chapter provides general instructions for using the created barcodes in applications. An 
explanation of the user interface and of the available barcode settings can be found in the following 
chapters. 

6.1 General 

You can export the barcodes created in Barcode Studio in the following ways: 

 Copy the barcode to the clipboard (as image) and paste it into your application. 

 Copy the barcode to the clipboard (as metafile) and paste it into your application. 
(Available under Microsoft Windows only.) 

 Export the barcode to an image file. 

 Export a series of barcode images (batch job). 

Before exporting a barcode you have to adjust the required barcode settings. The size of the resulting 
barcode image can be controlled by changing the dimensions (width, height, and module width) and 
the output resolution (DPI) – see also section 7.7.2 . These settings apply to all kinds of export 
operations.  

6.2 Resolution and Readability 

► Do not resize exported barcode images with image manipulation software (like Photoshop®)! 
The quality and the readability might suffer! 

► Whenever possible, let Barcode Studio create the barcode in the required size and resolution 
to avoid resizing later on. 

6.2.1.1 Barcode Quality 

When exporting the barcode to a bitmap image (BMP, GIF, JPG, PNG, TIF), it must be converted 
from its internal resolution (high) to a graphical pixel resolution (low). During this process (rasterizing) 
the module width can vary due to rounding errors. 

When exporting a barcode to a vector based image format (EPS) or as metafile to the clipboard, the 
internal representation of the barcode symbol allows very high resolutions (which are independent of 
the adjusted dpi). Thus it is recommended to use vector based image formats (EPS) whenever 
possible. However, in the context of certain applications (e.g. web applications) it is inevitable to use 
bitmap images. 

The readability of a barcode can be estimated by considering the quality watch (see section 7.1, ). 
The quality of a barcode depends on the selected output resolution, size and content. To ensure an 
optimal readability check the option “Optimize”. 

6.2.1.2 Module Width 

Larger module widths usually lead to a better readability of a barcode. In practice, for most linear 
barcodes, the module width should never be less than 0.19 mm.  
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6.3 Export to File 

If you want to export a barcode as an image file, select Export ► Export Barcode… from the menu 
or press the keyboard shortcut Ctrl+E. In the Save Image File dialog choose a file name and select 
the image file type (e.g. “Bitmap (*.bmp)”). Then confirm by pressing the Save button. 

The saved image can now be imported in your target application. (Example: In Microsoft® Word you 
can insert the barcode image by selecting Insert ► Image ► From File… from the menu.) 

► The exported barcode symbol will match the preview in Barcode Studio exactly. 

► For a list of available image formats, please refer to Appendix C. 

► If you export images with a bitmap based file format (see Appendix C), resizing of the imported 
image is not recommended! 

6.4 Copy to Clipboard (As Image) 

To copy the current barcode as an image to the clipboard, you have to select Copy to Clipboard (As 
Image) from the menu (located in the Export submenu) or from the toolbar. You can also press the 
keyboard shortcut Ctrl+B. 

Then switch to your target application and paste the barcode (e.g. in Microsoft® Word) by pressing 
Ctrl+V (or by selecting Edit ► Insert from the menu). 

► Resizing barcode images may result in a loss of quality, in the worst case in unreadable 
barcodes.  

6.5 Copy to Clipboard (As Metafile) 

To copy the current barcode as vector based metafile (EMF) to the clipboard select Copy to Clipboard 
(As Metafile) from the menu (located in the Export submenu) or from the toolbar. You can also press 
the keyboard shortcut Ctrl+M. 

Then switch to your target application and paste the barcode (e.g. in Microsoft® Word) by pressing 
Ctrl+V (or by selecting Edit ► Insert from the menu). 

► Metafiles can only be used under Microsoft® Windows. 

► Due to the vector based format you may resize the imported image within your target 
application without heavy losses in readability. 

► The resulting barcodes may differ in dependence of the selected resolution and target 
application from the preview in Barcode Studio in size.  

6.6 Export Data List 

Data lists are used for exporting a series of barcode images and/or for label printing. Such a data list 
can be imported, generated and edited. See also chapter 8 Data List and 9 Label Printing. 
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7 Barcode Studio User Interface 

7.1 Main Window 

 

  
Figure 3: User Interface 

The main window is split into the following areas: 

 Menu (see section 7.2) 

 Toolbar (see section 7.3) 

 Barcode View (see section 7.6) 

 Quality Watch (see section 0) 

 Barcode Settings (see chapter 7) 

 2D Settings (available only for certain Barcode Symbologies) 

 Barcode Types and Templates (see section 7.5) 

7.2 Menu 

The menu gives you access to the following functions: 

7.2.1 File 

New Creates a new document (with initial barcode settings). 

Shortcut: Ctrl+N 

Open… Opens an existing barcode settings file (*.bc). 














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Shortcut: Ctrl+O 

Save Settings 

Save Settings As… 

Saves the current barcode settings (symbology, dimensions, module width, etc.) into a file. 
Barcode settings files have the extension .bc. 

Shortcut: Ctrl+S (for Save) 

Export Barcode… Exports the barcode to a picture file. 

Shortcut: Ctrl+E 

Save As Template… Saves the current barcode settings as template file. 

Refresh Templates Refreshes the template list. 

Shortcut: Ctrl+R 

Print Barcode Info… Prints the barcode and the most important settings (size, resolution, etc.). 

Print Labels… Prints the data list as labels (see also chapter 9).  

Shortcut: Ctrl+P 

 Hints for Printing: 

 The output resolution and also the values for quality and deviation depend on the printer 
settings.  

 Note: Inkjet printers sometimes produce better results if the bar width reduction is used 
(see also section 7.8.2.4). 

Exit Exits Barcode Studio. 

Shortcut: Ctrl+Q 

7.2.2 View 

Zoom In Increment the zoom factor in the barcode view. 

Shortcut: Ctrl++ 

Zoom Out Decrement the zoom factor in the barcode view. 

Shortcut: Ctrl+- 

Reset Zoom Zoom is turned off. The barcode is shown in its original size. 

Auto Zoom Auto-Zoom mode is turned on or off. In Auto-Zoom mode the zoom factor is automatically 
adapted to the window size. 

Zoom Dialog Opens the zoom dialog. 

 Hint: 

 The zoom commands do not change the real size of the barcode but only the view size. 

7.2.3 Data List 

File Import… Imports data from a text file and adds it to the data list. 

Shortcut: Ctrl+I 

Create Sequence… Creates a data sequence and adds it to the data list. 

Save as CSV File… Export data list as *.csv file. 

7.2.4 Export 

Export Barcode… Exports the barcode to a picture file. 

Shortcut: Ctrl+E 

Copy to Clipboard (As 
Image) 

Copies the barcode as image to the clipboard. 

Shortcut: Ctrl+B 

Copy to Clipboard (As 
Metafile) 

Copies the barcode as metafile to the clipboard (not available on macOS). 

Shortcut: Ctrl+M 

Export Data List… Exports the data list as a series of barcode images. 

Shortcut: Ctrl+L 

7.2.5 Tools 

Options… Specifies the Application Options (see Chapter 10). 

7.2.6 Help 

Help Opens the documentation. 

Shortcut: F1 
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Barcode Reference Opens the barcode reference document in the web browser. 

TEC-IT Website Opens the page www.tec-it.com in the web browser. 

YouTube Opens a page with videos about Barcode Studio in the web browser. 

Facebook Opens the Barcode Studio web site on Facebook. 

Twitter Opens the Barcode Studio Twitter page. 

LinkedIn Opens the Barcode Studio LinkedIn page. 

Blog Opens the TEC-IT Blog web site. 

Buy Barcode Studio Opens the TEC-IT order form in the web browser. 

License... Opens the dialog for entering your license data. 

Refresh License.... Check whether a license of a former version of Barcode Studio may be updated. 

Check For Update… Checks for updates of Barcode Studio. 

About Barcode Studio Displays information about the application, version number and copyright. 

7.3 Toolbar 

The toolbars offer following functions: 

 
New Creates a new barcode (with pre-defined settings). Shortcut: Ctrl+N 

 
Open Opens an existing barcode settings file (*.bc). Shortcut: Ctrl+O 

 
Save Saves the current barcode settings to your hard disk. Shortcut: Ctrl+S 

 
Print Prints the data list as labels. Shortcut: Ctrl+P 

 
Zoom In Increment the zoom in the barcode view. Shortcut: Ctrl++ 

 
Zoom Out Decrement the zoom in the barcode view. Shortcut: Ctrl+- 

 
Reset Zoom Zoom is turned off. The barcode is shown in its original size. 

 
Export Barcode Exports the barcode to a picture file. Shortcut: Ctrl+E 

 
Copy to Clipboard (As Image) Copies the barcode as image to the clipboard. Shortcut: Ctrl+B 

 
Copy to Clipboard (As Metafile) Copies the barcode as metafile to the clipboard. Shortcut: Ctrl+M 

 
Export Data List Exports the data list as a series of barcode images. Shortcut: Ctrl+L 

 
Help Opens the documentation. Shortcut: F1 

 

7.4 Quality Watch – Status Section 

  
Figure 4: Quality Watch 



https://www.tec-it.com/
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7.4.1 Quality 

The higher the quality the better the readability of the barcode. It depends on the output resolution 
and the print ratio of the barcode and can be improved by changing the module width to an appropriate 
value. To do so, select “Pixel” as measurement unit and set the module width to an integer value (1, 
2, 3, etc., 25, etc.). 

The field “Quality” will report one of the following values: 

Tolerance Quality Description 

Perfect 100% Optimal output quality.  

Fair 70-99% Should be readable with most barcode scanners. 

Poor 50-69% May be readable. 

Bad! 1-49% Not readable in most cases. 

Data Loss! 0% Total or partly loss of information. Unreadable barcode. 

Table 2: Barcode Qualities 

7.4.2 Hint Box 

The hint box  displays information about the current barcode quality as well as recommended 
actions for improving the readability. 

7.4.3 Total Size 

The total size of the barcode including text and quiet zones. 

7.4.4 Symbol Size 

The symbol size of the barcode without text and quiet zones. 

7.4.5 Character Count 

Displays the number of characters in the barcode data. 

7.4.6 Resolution 

The current output resolution in dpi (dots per inch). 

7.5 Barcode Types and Templates 

7.5.1 Barcode Type 

Select the required barcode type (= symbology) from the Barcodes list (see Figure 3, ). For a better 
overview the list is divided into Linear Barcodes, 2D Codes, Postal Codes, GS1 DataBar, and Health 
Care Codes. 

► For 2D codes like Aztec Code, Codablock-F, Data Matrix, DotCode, Han Xin Code, MaxiCode, 
Micro PDF417, Micro QR Code, PDF417, QR Code®, GS1-DataBar Stacked and variants, as 
well as for all symbologies which are derived from these (HIBC, QR-Code (JIS), etc.), and for 
all Composite Symbologies you need a 2D license. For the other symbologies a 1D license is 
sufficient. 

If you want to learn more about the selected symbology, please examine the Barcode Reference from 
the Help menu. 

If a filter is active the number of shown barcode types is displayed in the tab header. 
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7.5.2 Template 

Select the required template from the Templates list. If you choose a template all previously adjusted 
settings are overwritten with the template settings. 

You can add your current configuration to the templates by saving it with Save As Template… from 
the File menu. To refresh the template list choose the menu item Refresh Templates. 

If a filter is active the number of shown templates is displayed in the tab header. 

7.5.3 Filter  

In order to find the desired barcode type or template more easily, the user can add a filter text in the 
field below the Barcodes / Templates list. Filters restrict the elements shown by the lists. 

The user may switch between two filter options by Text or by Encodable Data, what can be done by 
clicking the link with the opposite text. 

7.5.3.1 Filter by Text 

The affected lists only show those list entries that contain the filter text or are related to it. This 
option applies to both, Barcodes and Templates list.  

7.5.3.2 Filter by Encodable Data 

The Barcode list is restricted to the barcode types that are able to encode the filter data. 

   
Figure 5: Filter by Text  Filter by Encodable Data 

7.6 The Barcode View 

 
Figure 6: Barcode View 
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The Barcode View shows the barcode in its actual appearance (as it will be printed). 

To change the size of the barcode, enter the required dimensions in the “Appearance” section (see 
section 7.7.2). The quality of the barcode depends on the output resolution and on the module width. 
You will find a quality watch in the “Status” section (see section 0). 

7.7 Page General 

7.7.1 Data 

 
Figure 7: Data Section 

7.7.1.1 Barcode Data 

The barcode content is entered in the field “Barcode Data”  or by using the “Data Input Assistant” 
. The assistant allows the input of unstructured raw data as well as the comfortable input of special 
data formats (e.g., the contact data for a business card). However such data formats are not 
supported by all barcode types. The assistant may also be used for importing barcode data from a 
text file. 

Please note: 

► Each barcode type is able to represent a specified set of data-characters. Some barcode 
symbologies can hold digits. Others may contain alphanumeric characters (digits + letters + 
punctuation characters). Again, others may use the full ASCII character set. 





 



 
 
 

Page 24 of 86 

 

Barcode Studio User Manual  

7.7.1.2 Data Input Assistant 

 
Figure 8: Data Input Assistant 

The Data Input Assistant allows you to comfortably enter the barcode data in different formats. 
Depending on your selection in  a different input mask will be show in . E.g., if you have selected 
a business card format in , then  will show the corresponding input fields for first name, last name, 
company, etc. If you have selected the GS1 format then  will show a table for editing the single AIs 
(Application Identifiers) in the barcode (see example below). Barcode Studio will do the correct 
formatting for the particular barcode data automatically. The formatted data can be inspected in . 

► The number of available data formats in  depends on your current barcode selection. For 
Code 128 the editing will be restricted to raw data. For other symbologies (like QR Code®) a 
variety of data formats is available. 

► Besides that Barcode Studio offers the possibility to specify your own data formats. If 
required, please contact us! 

Furthermore the assistant allows you to import barcode data from a text file (button Load File…). For 
clearing all data fields, please use the Reset button. 

The data input for the “Raw Data” format (pre-selection) is quite similar to the input in the main 
window. However the assistant offers you the additional possibility to enter the data in a multi-line edit 

control (use the button ). 

Below you will find examples for editing different data formats: 









 
 
 

Page 25 of 86 

 

Barcode Studio User Manual  

Example Calendar Entry:  
(As symbology the QR Code is used) 

 
Figure 9: Data Input Assistant – vCalender 

Example GS1 Application Identifier:  
(As symbology GS1 128 is used) 

 
Figure 10: Data Input Assistant – GS1 Application Identifier 
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7.7.1.3 Add Control Characters 

You can enter control characters directly in the edit field or use the context menu. Open the context 
menu by right-clicking in the edit field and choose Add Control Characters. Then select the control 
character to insert from the submenu. 

Because control characters are represented by special character combinations (like \F for FNC1), 
Barcode Studio activates escape sequences automatically (see section 7.8.1.3).  

 
Figure 11: Add Control Character 

For more information on all available control characters, please refer to the “Barcode Reference” 
available on www.tec-it.com or via the menu Help ► Barcode Reference. 

7.7.1.4 Check Digit Override 

Some barcodes with a predefined number of utilizable data characters (like all EAN, UPC, Postnet 
and RSS-14 codes) contain a check digit on a fixed position in the barcode data. 

Example: 

 
 

The EAN13 code consists of 12 utilizable digits and 1 check digit on 
the last position (). 

If you enter 12 digits as barcode data the check digit will be 
calculated and inserted automatically. However, you can also enter 
all 13 digits and override the calculated check digit. 

 

► Note: If the barcode data already contains a check digit, the barcode is only valid if the check 
digit is equal to the automatically calculated check digit. 

► Only if the check digit method is set to None (see section 7.8.1.1), the correctness of a check 
digit remains unchecked. Under normal circumstances you should not use this setting – we 
recommend relying on the automatic calculation of the check digit(s) by Barcode Studio. 

7.7.1.5 Composite Data 

The Composite Data field () is only enabled if the selected barcode type supports composite data 
(check if the Composite page is visible) and if a 2D Composite Component has been selected 
(“Auto”, “CC-A”, “CC-B” or “CC-C”) on that page. 

► You can also enter the composite data in the Barcode Data field by separating the composite 
data from the linear barcode data by the vertical bar character "|". 

 

https://www.tec-it.com/
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7.7.1.6 Hex Data 

If this option is selected (see Figure 7, ) the barcode data is treated as hexadecimal data. This 
property applies to the barcode data field and to the composite data. 

Whenever Hex Data is enabled, Barcode Studio treats manually entered data as well as imported 
data as a hexadecimal character sequence. This sequence is internally converted to a normal 
character sequence before a barcode is generated. 

7.7.1.7 Example Data 

If the option “Example Data” is selected (see Figure 7, ), Barcode Studio provides a valid example 
data string for the currently selected barcode type. The data is adapted automatically if you change 
the symbology. 

7.7.2 Appearance 

  
Figure 12: Appearance Section 

7.7.2.1 Unit 

Field  specifies the measurement unit for displaying and/or entering the dimensions of the barcode. 
Possible values are:  

 Millimeter 

 Inch 

 Mils (=1/1000 inch)  

 Pixel 

 Point 

 Micrometer. 

7.7.2.2 Dimensions (Width, Height) 

Use the settings  and  to change the width and the height of the barcode. The preview is updated 
immediately. 

Unit Description 

Millimeter The width and the height of the barcode in millimeters. 

The physical width (in pixels) can be calculated as follows:  
width (pixels) = width (mm) / 25.4 * resolution (dpi). 

Inch The width and the height of the barcode in inches. 

The physical width (in pixels) can be calculated as follows:  
width (pixels) = width (inch) * resolution (dpi). 

Mils The width and the height of the barcode in mils. 

The physical width (in pixels) can be calculated as follows:  
width (pixels) = width (mils) / 1000 * resolution (dpi). 

Pixel The width and the height of the barcode in pixels. 

The width and the height are specified in pixels. The resulting dimension on the screen depends 
on the adjusted resolution (dpi). 

Point The width and the height of the barcode in points. 



 





 
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The physical width (in pixels) can be calculated as follows:  
width (pixels) = width (pt) / 72 * resolution (dpi). 

Micrometer The width and the height of the barcode in micrometers. 

The physical width (in pixels) can be calculated as follows:  
width (pixels) = width (µm) / 25400 * resolution (dpi) 

Table 3: Units 

7.7.2.3 Module Width 

The module width is entered in field . 

Every barcode is divided into several "modules". A module is the smallest bar (or space) segment. 
The module width is the fundamental measuring unit for barcodes. All bar and space widths base 
on this setting. A change of the module width causes a change of the barcode width and vice 
versa. 

Exceeding the lower limit of the module width leads to unreadable barcodes (e.g., if the module width 
is smaller than 1 pixel). The minimum limit depends on the resolution of screen, printer, or image. 

► The module width should be 0.19 mm or greater, otherwise barcode readers will have 
problems to scan the barcode. 

7.7.2.4 Resolution (DPI) 

Enter the required resolution in : 

Resolution (DPI) Description 

Screen Resolution The image will be exported in exact the same size as displayed in Barcode Studio.  
Depending on your operating system and on the display settings within the operating system 
this resolution may differ. Typical values are 72, 96 or 120 dpi. 

Printer Resolution Use the DPI setting of the currently selected printer. 

72 dpi (BMP) Create the image with 72 dpi. 

96 dpi 

 : 

2540 dpi 

Create the image with the given dpi.  
Higher dpi values result in larger (and more detailed) image files. 

Custom Resolution… Create the image with the custom resolution added in the field aside. 

Table 4: Resolution Settings 

► To increase the accuracy of the barcode symbol you can increase its resolution.  

► Consider that the resolution set in Barcode Studio must fit to the resolution of the printer or 
the target application. 

► Image Export: Most applications show (and print) images (and therefore barcodes exported 
as image) in screen resolution. If the resolution of the barcode image is higher than the screen 
resolution, the output size will be displayed bigger than in Barcode Studio.   
Example: If your screen resolution is 96 dpi and the exported image has a resolution of 300 
dpi it will be displayed about 3 times as large as in Barcode Studio. 

► However, only few professional layout applications consider the resolution correctly.  

► The dpi value can only be stored in certain image formats!  
E.g., when exporting an image as GIF file, the adjusted resolution (dpi) will not be stored. Only 
the formats BMP, JPG, PNG, and TIF are capable of storing the resolution.  
For detailed information, please refer to Appendix C. 

7.7.2.5 Optimize 

If the “Optimize” option  is checked, the module width of the barcode will be set to a whole-numbered 
pixel size (to the nearest lower value). Hereby the pixel deviation is reduced to a minimum or 
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eliminated completely.  
In other words: The barcode is printed using whole-numbered pixel sizes only. This avoids aliasing 
effects and guarantees an optimal scanning quality. 

► If the “Optimize” option is checked, the module width will be adjusted for optimum output quali-
ty. 

► This setting can be very helpful especially for lower resolutions. 

► The barcode view shows the barcode symbol in optimal quality only, if the resolution was set 
to “Screen Resolution”. The preview is not detailed enough to display higher resolutions 
correctly. More detailed output can only be achieved on the according output devices (printer, 
image, etc.). 

7.7.2.6 Reset Button 

Use the link “Default Settings”  to reset the barcode to its initial size. 

7.7.3 Text Placement 

This section describes the settings regarding the human readable text. 

  
Figure 13: Text Placement Section 

7.7.3.1 Show Text 

Choose whether and where the human readable text is shown. Allowed values are No Text, Below 
Barcode (default), and Above Barcode. 

Many barcode types, as for instance the 2D symbologies, do not have a human readable text. For 
these types the option cannot be changed. 

Above Barcode cannot be enabled in conjunction with barcode types like EAN 8, EAN 13, UPC A, or 
UPC E. 

7.7.3.2 Alignment 

This property adjusts the alignment of the human readable text (Default, Left, Right, and Center). 

7.7.3.3 Text Distance 

This property adjusts the distance between the “human readable text” and the barcode (in mm). 

7.7.3.4 Font 

Click the  button to select the font for the human readable text. The selected font is displayed in 
text box . 


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7.7.3.5 Auto-Sizing 

If enabled the font size is calculated automatically based on the module width of the barcode. If not 
set to Default, letter spacing and text distance grow and shrink with the font size. 

7.7.3.6 Letter Spacing 

This property adjusts the spacing between the letters of the human readable text (in pt.). 

 

7.8 Page Settings 

7.8.1 Advanced Barcode Settings 

   
Figure 14: Advanced Barcode Settings Section 

7.8.1.1 Escape Sequences 

The use of escape sequences is appropriate if you need to encode control characters like carriage 
return or FNC1 into the barcode. 

This option specifies, whether escape sequences (like “\n”) shall be translated or not (default: no). 
Each escape sequence starts with a backslash (“\”) and is followed by one or more characters. For a 
list of recognized escape sequences, please refer to the additional document “Barcode Reference” 
available via the menu Help ► Barcode Reference or from www.tec-it.com. 

► If escape sequences are activated, the backslash character can’t be used directly in the bar-
code data. It must be replaced by a double back-slash “\\” in order to be encoded correctly. 

7.8.1.2 Check Digit 

This property specifies the check digit calculation method. In order to guarantee that the barcode data 
is going to be read properly a check digit can be added at the end of the utilizable data. A comparison 
of the barcode content with the check digit informs the scanning device (scanner) about incorrect 
scans and forces the device to repeat or reject the scan. The check digit calculation method is 
standardized for certain common barcodes types. Using check digits is mostly optional – but often 
recommended for particular symbologies and standards. 

When set to default the check digit is calculated according to the specification of the selected 
barcode. Modifications are admissible for barcodes with selectable check digit methods or for special 
applications only. 







https://www.tec-it.com/
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For additional information on check digit calculation, please refer to the “Barcode Reference” available 
from www.tec-it.com or via the menu Help ► Barcode Reference.  

7.8.1.3 Encoding / Code Pages 

With the fields Encoding Mode () and Code Page () the user can affect the interpretation of the 
input data. 

For a general overview about encoding and code pages, please refer to the “Barcode Reference” 
available from www.tec-it.com or via the menu Help ► Barcode Reference. 

► Data is always passed as UNICODE stream to Barcode Studio. Since UNICODE characters 
always consist of more than one byte and most of the barcode types are only able to encode 
one byte per character, it is not always clear how the input data should be interpreted. So we 
give you the possibility to decide yourself. 

► Per default the input data is converted to the selected Code Page (see below). If other kinds 
of interpretations are needed, you have to change this property. 

You have following possibilities: 

Value Description 

Selected Code Page Converts the input data to the code page, which is selected in the property Code Page. 
(default) 

Lo-Bytes only Considers only the lower bytes of the input characters, the higher bytes are ignored.  

Lo- before Hi-Byte The data is passed as it is. No conversion is done. All bytes are considered. A lower byte 
is passed before the higher byte. 

Hi- before Lo-Byte Consider both bytes but change the order of lower and higher byte. That means a higher 
byte is encoded before the lower byte. 

Table 5: Compression 

The code page is related to the property Encoding Mode. It is only considered if the encoding mode 
is set to Selected Code Page. You can choose between several pre-defined code pages (e.g. ANSI, 
ISO 8559-1 Latin I, UTF-8, Shift-JIS…) or add the ID of a custom code page by selecting Custom 
Encoding… and by entering the ID in the edit field aside.  

7.8.1.4 Bearer Bars 

Select the kind of bearer bars you want to use. Bearer bars help a decoder to detect the full width of 
a barcode and reduce the possibility of partial scans (decoding only a part of the symbol). You can 
change the width of the Bearer Bars in . 

7.8.1.5 Notch Height 

This property adjusts the height at which the synchronization bars (e.g. the double lines in EAN on 
the left, center and on the right side) extend the regular barcode height. 

https://www.tec-it.com/
https://www.tec-it.com/
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7.8.2 Drawing 

  
Figure 15: Drawing Section 

7.8.2.1 Quiet Zone 

Click the Adjust Quiet Zones… button to open the Quiet Zones dialog.  

This property adjusts the sizes of the quiet zones around the barcode. The sizes can be given in 
several units like number of modules, Millimeters, Inches, Mils, and Pixels. 

 
Figure 16: Quiet Zones 

You can configure the quiet zone for all four sides of the barcode independently from each other. By 
clicking Reset Values all values are reset to zero. 

7.8.2.2 Colors / Transparency 

Click the Change Colors… button to open the Colors/Transparency dialog.  

 
Figure 17: Colors Dialog 
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Click the  button beside the color that you want to change. Then select the desired color in the 
appearing dialog. 

Fore Color The foreground color of the barcode (color of the bars). 

Back Color The background color of the barcode (color of the spaces). 

Text Color The color of the “human readable text”. 

Back Style Mode for drawing the background of the barcode. The background can be set either to transparent 
(background shines through) or opaque (= default; background is overwritten with the background 
color). This setting is also relevant if you use copy and paste (clipboard). 

 

  
Figure 18: Color Selection Dialog for Microsoft Windows 

Because Microsoft Windows does not offer to select colors from the CMYK model by default, Barcode 
Studio offers a dialog where the user may choose between the color models RGB or CMYK. Change 
the color by selecting the color shades directly or click the button to open the system color dialog. 

7.8.2.3 Rotation 

This property defines the barcode rotation. Possible values are 0°, 90°, 180°, and 270°. 

7.8.2.4 Bar Width Reduction 

When printing on inkjet printers, the ink that is absorbed by the paper tends to diffuse. Setting the bar 
width reduction allows you to work against this spreading of ink. This property is also useful for laser 
printers with high toner saturation. 

The bar width reduction can be specified in several measure units like percent of the module width, 
mm, Inch, and Mils. For instance, if the unit is set to percent and the value is set to 20 all bars will be 
narrowed by 20 percent of the module width. 

► Be careful: When using this feature we recommend you to do several test scans to make sure 
that the barcode can be scanned correctly. A common value to start with is 15%. Setting the 
bar width reduction to more than 50 percent might leave the barcode unreadable! 

► If you need a different horizontal and vertical bar width reduction, you can do this by adding 
following option string to: 
More Settings… / Options:  
DRAW_BarWidthReduction_Values={x=[double] y=[double] unit=[enum]} 
where x is the horizontal reduction, y is the vertical reduction, 
and unit is the reduction unit (1=pixel, 2=mm, 3=mils, 4=inch). 
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7.8.3 More Settings 

  
Figure 19: Dialog More Settings 

7.8.3.1 Format/Subset 

The format string is used for formatting the utilizable data of the barcode according to defined rules. 
It operates with substitute symbols to indicate how the data shall be structured.  
With the format string it is possible to insert constant characters to the barcode data. Control 
characters make it possible to change the Subsets for Code 128, EAN 128 and UCC 128 or to define 
the desired start/stop character of CODABAR. 

For more information on format strings, please refer to the “Barcode Reference” available from 
www.tec-it.com or via the menu Help ► Barcode Reference. 

7.8.3.2 More Options 

Via the field Options you can change predefined barcode settings. You can find a list of valid options 
in the description of the function BCSetOptionsA on 

www.tec-it.com/Documentation/TBarCode11_Library_Reference/group___options.html. 

7.8.3.3 Print Ratio 

The print ratio describes the relationship between the different bar- and space-widths of a barcode 
(do not mix this up with the width/height ratio of a symbol!). It is specified by a list of colon-separated-
values. The list starts with n bar widths, followed by m space widths. The numbers n and m depend 
on the barcode type. 

The single values specify a multiple of the module width: 

 1   “Equal to the module width”,  

 2   “Twice the module width”,  

 … 

You can use the Default Print Ratio  as a template for a customized Print Ratio value. It shows 
how many different bar and space widths are used for the selected barcode type. The absolute width 
of a bar (or space) is calculated using the values of the print ratio multiplied with the module width. 

Example: If a barcode element has 4 different bar widths and 4 different space widths, the print ratio 
could look like this (e.g. for Code 128): 1:2:3:4:1:2:3:4.  
The first 4 numbers ("1:2:3:4") stand for the bar widths, the last 4 numbers for the space widths (in 
this case, they are the same). The smallest bar is "1" module wide, the next larger is "2" (thus twice 
as wide as the smaller bar) and so on. 

► Modifications of the print ratio make only sense for special applications! E.g., for the Code 
2OF5 interleaved the print ratio can vary from 1:2 to 1:3. 

► Use this option with care! Barcodes may become unreadable when using wrong print ratios. 



https://www.tec-it.com/
https://www.tec-it.com/Documentation/TBarCode11_Library_Reference/group___options.html
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For additional information on print ratios, please refer to the “Barcode Reference” on www.tec-it.com. 

7.9 Page Logos and Effects 

 
Figure 20: Logos and Effects 

7.9.1 Logos 

► Attention: The embedding of logos can endanger readability. We strictly recommend 
checking the readability of every single barcode. 

► A change does make only sense for special applications like advertisements, fun barcodes, 
etc., that do not enforce the readability of the barcodes. 

A logo can be displayed and changed only if “Show Logo” is checked. 

7.9.1.1 Image File 

Selection of the logo image file in . 

7.9.1.2 Full Size 

If checked the logo is stretched to the full size of the barcode (). In order to gain a useful result, you 
should also choose a suitable display mode. 

7.9.1.3 Alignment 

Defines the alignment and so the position of the logo within the barcode (). 















https://www.tec-it.com/
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7.9.1.4 Offset 

The offset specifies the relative horizontal and vertical distance of the logo from the position given by 
the alignment (). 

7.9.1.5 Width/Height, Lock Ratio 

This setting defines the width and the height of the logo (). If “Lock Ratio” is checked, the ratio 
between width and height is retained when the size changes. 

7.9.1.6 Display Mode 

The display mode () specifies, how the logo shall be embedded into the barcode. You can choose 
among following options: 

 Logo Above  The logo is drawn in front of the barcode. 

 Logo Below  The logo is drawn behind the barcode. 

 Mask  The logo is drawn only over the bars. 

 Custom Settings  Detailed Settings by clicking . (see 7.9.2 Custom Display Settings) 

7.9.1.7 Default Settings 

By clicking “Default Settings” all logo settings are reset to default. 

7.9.2 Custom Display Settings 

  
Figure 21: Custom Display Settings 

7.9.2.1 Display Mode 

Set here the detailed display mode. 

7.9.2.2 Logo Transparency 

This setting defines the transparency of the logo in the range between opaque and invisible. 

7.9.2.3 Transparency Color 

Choosing of a single transparency color. If the selected color occurs in the logo, it is drawn 

transparently. (See also  in Figure 21 – white was chosen as transparency color ). 

7.9.3 Effects 

7.9.3.1 Draw Mode 

► Attention: For average use we strongly recommend to use only Draw Mode Rectangles. 
Using another mode can endanger readability. 

► A change does make only sense for special applications like advertisements, fun barcodes, 
etc., that do not enforce the readability of the barcodes. 




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The draw mode () specifies which shape the bars should have. Usually bars are drawn as 
rectangles – only this selection applies to the barcode standards. For special applications (like 
advertisements, etc.) you can also choose other shapes. 

Draw Mode Description 

Rectangles Standard. Bars are drawn as rectangles. 

Attention: For the average use we strongly suggest using only this setting. 

Circles/Ellipses Bars are drawn as circles or ellipses depending on the outline of the bar. 

Big Circles/Ellipses Like above, but the circles or ellipses are drawn a bit bigger. In matrix codes the circles 
overlap which increases the readability of the barcode in comparison to the settings 
Circles/Ellipses. 

Rounded Rectangles Bars are drawn as rectangles with rounded corners. 

Images Bars are drawn as images. The name of the image file must be set in field Image File. 

Table 6: Draw Modes 

7.9.3.2 Image File 

If the user selects the drawing method Image, he has to enter the name of the image file (.bmp, .jpg, 
.gif, .png, .tif) here. 

7.10 Page Captions 

  
Figure 22: Captions 

The texts which are specified here are printed above and below the barcode. Currently two captions 
above and two captions below the barcode are supported. 

In order to print a caption, it must be activated. For each caption you can specify the content, the 
alignment, the text distance, and the font style. 


  
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7.10.1 Text Position 

The checkboxes in  allow you to activate one or more captions. The caption texts are printed in the 
following order (from top to bottom): Caption Above, Caption Above 2, barcode, Caption Below, 
Caption Below 2. 

7.10.2 Text 

In field  you specify the caption text. 

► If the caption exceeds the available width of the barcode, you can add a quiet zone (left/right) 
to provide more space (see 7.8.2.1). 

7.10.3 Alignment 

This property adjusts the alignment of the human readable text (Left, Right, and Center). 

7.10.4 Text Distance 

This property specifies the distance to the next inner element: either to the barcode or to the next 
inner caption. 

If the caption is adjacent to the barcode, then the Distance describes the space between the caption 
and the barcode. If an additional caption is located between the caption and the barcode, then the 
Distance describes the space between these two captions. 

The distance may also be less than 0. So you can print captions within the barcode or on the same 
line with another caption. 

7.10.5 Font 

Click the  button to select the font for the caption text. The selected font is displayed in the text box 
. 

7.10.6 Letter Spacing 

This property specifies the distance between two letters in points. The default value is 0. 
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7.11 Page Info 

7.11.1 User Info 

 
Figure 23: User Info Section 

7.11.1.1 Title and Comment 

Users can enter a title and a comment in HTML-Format. If specified, the title and the comment are 
displayed as info text below the barcode. The info text can be used to provide other users with 
important information. 

Possible fields of application:  

 Give a short description of specific barcode settings. 

 Provide information about the required input data format. 

 Advice other users to perform the necessary steps for the generation of correct barcodes. 

 … 
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Figure 24: Info Text 

To distribute settings with an info text, please perform following steps: 

► Change all settings according to your needs. 

► Enter the info text to the title/comment field. 

► Save the settings to a file. 

► Provide this file to all users who need it. 

7.11.1.2 Template Category 

The template category is used for categorizing templates in the Templates tree. 

7.11.1.3 Keywords 

The field Keywords contains information related to a template. It can be used as additional 
information for filtering the templates list. 
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7.12 2D Settings 

7.12.1 PDF417 / Micro PDF417 

 
Figure 25: PDF417 / Micro PDF417 Properties 

The PDF417 / Micro PDF417 page is used for modifying the standard behavior of the 2-dimensional 
barcode types PDF417, Micro PDF417 and for all derived barcodes (PDF417 Truncated, etc.). 
PDF417 divides the data content into rows and columns. It is a so called “stacked symbology” with 
error correction capabilities. 

► Be careful when modifying these adjustments. Always make a test scan in case of doubt! 

7.12.1.1 Encoding Mode 

Determine whether to enforce binary encoding. In Binary Encoding mode the encoding algorithm 
does not try to calculate the smallest possible symbol, but it uses binary encoding for all characters. 
This is recommended for binary input data and for barcode generation with optimal speed. 

7.12.1.2 Rows [3..90] 

The number of rows. This value must be between 3 and 90.  

Default: The number of lines is calculated automatically based on the number of input characters. 

► This property is not available for the Micro PDF417 symbology! 

7.12.1.3 Columns [1..30] 

The number of columns. The value must be between 1 and 30. Start-, stop- and line-indicator columns 
are not taken into account.  

Default: The number of columns is calculated automatically based on the number of input characters. 

7.12.1.4 Row Height [mm] 

The height of an individual row in millimeters. If specified, the barcode height will remain locked at 
the specified value. (Modifying the barcode dimensions will only affect the barcode width.) 

Default: The row height is calculated automatically based on the number of input characters. 
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7.12.1.5 Error Correction Level 

The error correction level. The value can be between 0 (only error detection) and 8 (highest 
correction).  

Default: The level is calculated automatically according to the number of input characters (minimum 
2, maximum 5). 

► This property is not available for the Micro PDF417 symbology! 

7.12.1.6 Mode 

Specifies how data is encoded as Micro PDF417. In most cases the “Default” mode is the best choice. 

► Note: Often the scanner hardware does not support all modes listed below. – Please, check 
with your scanner first. 

 

Mode (Enumeration) Description 

Normal (Default) The input data is analyzed. Text, numeric or binary compaction mode will be used accor-
dingly (to generate the smallest symbol). 

GS1/UCC/EAN-128 
Emulation 

GS1/UCC/EAN-128 Emulation mode. Transmit ]C1 or ]L3 as symbology prefix. 

Use compaction for Application Identifier (AI) "01" + 14 digits. 

Code128 Emulation Code-128 Emulation mode. Symbology prefix will be ]C0 or ]L5. 

Code128 FNC1 2nd position Code-128 with FNC1 on second position will be emulated. Prefix: ]C2 or ]L4. 

Linked GS1/UCC/EAN-128 Linked GS1/UCC/EAN-128 emulation. Transmit ]C1 or ]L3. 

Indicates that the Micro PDF symbol is linked with a linear symbol (which may be required 
for a successful scan). 

Using this mode, the following AIs can be encoded with better compaction in the given 
order: 

 Date (AI 11, 13, 15 or 17) + lot number (AI 10) + other AI’s (optional). 
 Date (AI 11, 13, 15 or 17) + serial number (AI 21) + other AI’s (optional). 
 Date (AI 11, 13, 15 or 17) + other AI’s (optional). 

Note: This mode is not used with UCC EAN Composite Symbology (which uses linked 
symbols, too). 

05 Macro The preamble [ ( > RS 0 5 GS precedes the encoded data. The postamble RS EOT follows 
the bar code data. 

06 Macro The preamble [ ( > RS 0 6 GS precedes the encoded data. The postamble RS EOT follows 
the bar code data. 

CC-A Data Mode For special applications only: use Base-928 compaction and process input data as byte 
array. 

CC-B Prefix For special applications only: use binary compaction (Base-900), prefix symbol data with 
reserved symbology code word. 

Table 7: Micro PDF417 – Modes 

► This property is not available for the PDF417 symbology! 

7.12.1.7 Version 

Specifies the “size” of the symbol in terms of code word-columns and Micro PDF417 rows. 

► This property is not available for the PDF417 symbology! 

7.12.1.8 Macro PDF417 (Structured Append) 

Inserts a Macro PDF control block into the barcode. 
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PDF417 allows the user to spread the data across several symbols. This might be done if the data is 
too large to fit into a single symbol or for reasons of appearance and geometry. 

The so called “Macro PDF Control Block” carries information that relates its contents to the overall 
data. The properties described below are mandatory for the Macro PDF functionality. 

7.12.1.9 Segment Index 

Index of the actual data segment in the symbol chain. It starts with 1 and is increased for each 
additional symbol in the data chain. Value range = 1…99999.  
Note: when reading the encoded data with a scanner, the index will be zero-based. 

7.12.1.10 Last Symbol 

Identifies the last symbol in the data chain. If set to true, the “Last Segment Indicator” is put at the 
end of the Macro PDF control block. 

7.12.1.11 File ID 

The file id identifies all symbols, which belong to the same data chain. For reassembling, all data 
blocks having the same File ID are concatenated in the order of increasing segment index. 

7.12.1.12 Optional Settings 

These fields are optional and may be encoded into the Macro PDF417 control block on demand. 

 
Figure 26: Macro PDF417 – Optional Settings 

File name (alphanumeric) File name (variable length field). 

Segment count (numeric) Total number of data segments (range 1…99999). 

Time stamp (numeric) Time stamp (elapsed time in seconds since January 1, 1970 00:00 GMT). 

Sender (alphanumeric) Sender (variable length field). 

Addressee (alphanumeric) Addressee (variable length field). 

File size (numeric) Total number of bytes encoded (variable length field). 

Checksum (numeric) 16-Bit CRC checksum (using CCITT-16 polynomial x16 + x12 + x5 + 1 over the entire 
data). 

7.12.2 MaxiCode 

MaxiCode represents data, by drawing hexagonal items, which are arranged around a circular center 
(a so called "Bull's Eye"). The internal data structure is regulated by different "modes". The mode 
"Structured Carrier Message" was defined by the parcel transport service UPS®. Data can be encoded 
in two different error correction levels (SEC = Standard Error Correction and EEC = Enhanced E.C.). 
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With “Structured Append” you can divide larger quantities of data into several MaxiCode symbols – 
they are joined by the scanner. The maximum data capacity of one symbol is 93 characters. The 
actual quantity of the utilizable data depends on the selected mode, on the amount of special 
characters, on whether compressible numeric sequences are used and on the level of error 
correction. 

 
Figure 27: MaxiCode Properties 

7.12.2.1 Mode 

Mode (Enumeration) Description 

4 – Standard Symbol For numeric and alphanumeric character sequences (incl. standard error correction). 

2 – SCM (Numeric) Structured Carrier Message, up to 9 digits (postal code consist of digits only). 

3 – SCM (Alphanumeric) Structured Carrier Message, up to 6 characters (postal code consist of alphanumeric 
characters). 

5 – Full EEC Like mode 4 but with enhanced error correction (safer, but fewer utilizable data possible). 

Table 8: MaxiCode – Modes 

7.12.2.2 Undercut [0..100] 

The undercut influences the diameter of the hexagonal barcode elements. In new applications it is 
recommended (according to the AIM standard) to use an undercut setting of 75% (default). 

7.12.2.3 Preamble Options 

Used particularly in “Open System Standards”. Under “Preamble Date” the last two digits of a year 
can be entered. They are inserted automatically into the data stream in a predefined place. 

7.12.2.4 Structured Append 

If you want to encode large quantities of data you can “connect” several MaxiCode symbols by the 
use of “Structured Append". For each MaxiCode symbol an identification number must be assigned. 
This number is entered in the field “Index of this Symbol” and can range from 1 to 8. The index 
indicates the order, in which the data is joined after the reading/scanning process. The total number 
of arranged MaxiCode symbols must be entered in “Number of all symbols”. 

7.12.2.5 Structured Carrier Message (SCM) 

MaxiCode was originally developed by UPS® (United Parcel Service). The operating mode 
"Structured Carrier Message" (mode 2 and 3) supplies special data fields for UPS®-purposes: 
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”Service Class”, ”Country Code”, and ”Postal Code”. In “Mode 3” you can use digits as well as 
alphanumeric characters for the “Postal Code”. 

By using escape sequences it is possible to insert the values for date, preamble, service class, 
country and postal code directly into the barcode data (text property). To learn more about this feature, 
please refer to the additional document “Barcode Reference”, which is available from www.tec-it.com 
or via the menu Help ► Barcode Reference. 

7.12.3 Data Matrix 

► Please note, that Barcode Studio always uses ECC 200 error correction. 

 

 
Figure 28: Data Matrix (ECC200) Properties 

7.12.3.1 Code Format 

Code Format  (Enumeration) Description 

Default Standard format. 

GS1/UCC/EAN Special format defined by GS1/UCC/EAN. Used for encoding Application Identifiers. 
(FNC1 at 1st position). 

Industry Supports peculiar industry formats (FNC1 at 2nd position). 

Format 05 [)>Rs05Gs is encoded at the beginning of the code. 

Format 06 [)>Rs06Gs is encoded at the beginning of the code. 

Reader Programming Format used to program barcode reading devices. 

DP Postmatrix Special Format defined by „Deutsche Post“. Is used for mailing commercials. 

Table 9: Data Matrix – Modes 

7.12.3.2 Symbol Size 

The size of the symbols in number of rows and columns. Possible sizes are "10 x 10" to "144 x 144" 
modules for square symbols and "8 x 18" to "26 x 64" for rectangular symbols. If set to default, the 
minimal possible square size is used (depending on the input data). 

7.12.3.3 Enforce Binary Encoding 

Determine whether to enforce binary encoding. In Binary Encoding mode the encoding algorithm 
does not try to calculate the smallest possible symbol, but it uses binary encoding for all characters. 
This is recommended for binary input data and for barcode generation with optimal speed. 

https://www.tec-it.com/
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7.12.3.4 Show as Rectangle 

Determines if the Data Matrix symbol should be displayed as rectangle (checked) or as square 
(unchecked; default). 

7.12.3.5 Structured Append 

If you want to encode large quantities of data you can “connect” several Data Matrix symbols by the 
use of “Structured Append". For each Data Matrix symbol an identification number must be assigned. 
This number is entered in the field “Index of this Symbol” and can range from 1 to 16. The index 
indicates the order, in which the data is joined after the reading/scanning process. The total number 
of arranged Data Matrix symbols must be entered in “Number of all symbols”. The “File ID” has to be 
the same for all symbols within such a chain. 

7.12.4 QR Code® / QR-Code (JIS) / Micro QR Code / Swiss QR-Code 

The QR Code symbology is a 2-dimensional matrix symbology (similar to Data Matrix). Remarkable 
is the large data capacity (up to 3000 ASCII characters or 7000 digits). QR Code means Quick 
Response code – it was originally designed to read and decode symbols with high amounts of data 
within a minimum of time. The only difference between QR Code and QR-Code 2005 is the default 
code page. Whereas QR Code uses ISO 8859-1 Latin I, QR Code (JIS) uses Japanese Shift-JIS. 

The Micro QR Code symbology is based upon QR Code, but is adapted to encode only small 
quantities of data. It produces less overhead and smaller symbols. 

 
Figure 29: QR Code Properties 

7.12.4.1 Format / Application Indicator 

Format (Enumeration) Description 

Default Standard format. 

GS1/UCC/EAN Special format defined by GS1/UCC/EAN. Used for encoding Application Identifiers. 
(FNC1 at 1st position). 

Industry Supports certain industry formats (FNC1 at the second position). If you choose this value, 
you also have to fill in the field Application Indicator (2 digits or 1 letter). It determines to 
which industry format the input data corresponds. 

Table 10: QR Code – Modes 

► This property is not available for the Micro QR Code symbology! 
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7.12.4.2 Symbol Version (Size) 

The version (= size) of the symbol is specified by a version number, the number of rows and the 
number of columns. The range for QR Code symbols is from (1) 21 x 21 up to (40) 177 x 177 modules. 
The range for Micro QR Code symbols is from (M1) 11x11 to (M4) 17x17. 

If the property is set to default, the size is computed automatically based on the data to be encoded. 

7.12.4.3 Error Correction Level 

Defines the error correction level. You can choose from the following values: 

Error Correction Level  
(Enumeration) 

Description 

(L)ow Lowest level. Data recovery capacity is up to approximately 7%. 

(M)edium (default) Up to 15%. 

(Q)uartil Up to 25%. 

(H)igh Highest level. Up to 30%. 

Table 11: QR Code – Error Correction Levels 

► Not all versions (sizes) of the Micro QR Code support all levels of error correction. If you have 
selected a level, which is too high for the given symbol version, Barcode Studio automatically 
uses the highest possible level. 

7.12.4.4 Mask Pattern 

Specifies the mask pattern that is applied to the symbol to improve the readability of the code.  

Mask Pattern (Enumeration) Description 

Default The mask pattern is calculated automatically. 

0..7 (QR Code only) With the values 0 to 7 you choose the appropriate mask pattern. It would make sense 
to specify this setting directly if you have to optimize the computation time. The algo-
rithm to calculate the optimal mask is rather complex (and therefore very resource 
consuming). 

0..3 (Micro QR Code only) With the values 0 to 3 you choose the appropriate mask pattern. It would make sense 
to specify this setting directly if you have to optimize the computation time. Compared 
to QR Code the mask algorithm for Micro QR Code is rather fast and simple. 

Table 12: QR Code – Mask Patterns 

7.12.4.5 Compaction 

The multi-byte compaction mode. QR Code provides code compaction for various Multi Byte 
character encodings (Kanji, Chinese). This compaction can help to produce smaller barcodes. 

Compaction (Enumeration) Description 

Default multi byte compaction (Default) Automatically chooses the appropriate compaction method. 

No multi byte compaction Disables the multi byte compaction. 

Kanji character compaction Enables the compaction for Kanji characters. 

Chinese character compaction Enables the compaction for Chinese characters. 

Table 13: QR Code – Compaction 

QR Code supports compaction of Kanji characters (if present in the Multi Byte character set Shift JIS 
X 0208). The Kanji characters are compacted into a 12-Bit code word (instead of a 2 Byte / 16 Bit 
code word) – so they need less space in the symbol. It is recommended to enable this compaction 
only if you have Kanji characters in your input data. This mode should not be enabled for binary data! 



 
 
 

Page 48 of 86 

 

Barcode Studio User Manual  

7.12.4.6 Structured Append 

If you want to encode large quantities of data, you can “connect” several QR Code symbols by the 
use of “Structured Append”. For each QR Code symbol you have to assign a symbol identification 
number which is entered in the field “Index of this Symbol”. Its value can range from 1 to 16. This 
index indicates the order, in which the data is joined after the reading/scanning process. The total 
number of arranged symbols must be entered in “Number of all Symbols”. 

Chained QR Code symbols are identified by the parity byte. The parity byte must be identical in all 
symbols. The value can be calculated using the method „QR_StructAppParity“, which is part of 
TBarCode API. 

► This property is not available for the Micro QR Code symbology! 

7.12.5 Aztec Code 

 
Figure 30: Aztec Code Properties 

7.12.5.1 Format / Format Specifier 

Code Format (Enumeration) Description 

Default Standard format. 

GS1/UCC/EAN Special format defined by GS1/UCC/EAN. Used for encoding Application Identifiers. 
(FNC1 at 1st position). 

Industry Supports certain industry formats (FNC1 at the second position). If you choose this value, 
you also have to fill in the field Application Indicator (2 digits or 1 letter). It determines to 
which industry format the input data corresponds. 

Table 14: Aztec Code – Modes 

7.12.5.2 Symbol Size 

Defines the size of the symbol in rows and columns. Possible values range from „15 x 15" up to „151 
x 151" modules. If the property is set to default, the size is computed automatically based on the data 
to be encoded. 

7.12.5.3 Enforce Binary Encoding 

Specifies whether to enforce binary encoding. In Binary Encoding mode the encoding algorithm 
does not try to calculate the smallest possible symbol, but it uses binary encoding for all characters. 
This is recommended for binary input data and for barcode generation with optimal speed. 
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7.12.5.4 Aztec Runes Mode 

Enables the Aztec Runes mode. Aztec Runes are a special kind of Aztec Code symbols and are used 
to generate small and very fast readable markers. Aztec Runes can only encode integer values from 
0 to 255. 

7.12.5.5 Error Correction 

Defines the error correction level in percent. You can enter a value between 1 and 89 percent. The 
value “Default” is equivalent to 23 percent. 

7.12.5.6 Structured Append 

If you want to encode large quantities of data you can “connect” several Aztec Code symbols by the 
use of “Structured Append". For each Aztec Code symbol an identification number must be assigned. 
This number is entered in the field “Index of this Symbol [A..Z]” and can range from “A” to “Z”. The 
index indicates the order, in which the data is joined after the reading/scanning process. The index of 
the last symbol must be entered in “Number of all Symbols [A..Z]”. 

Chained Aztec Code symbols are identified by the “Message ID”. The “Message ID” must be identical 
in all symbols. 

7.12.6 Codablock-F 

The Codablock-F property page is used to adjust symbology specific parameters. Similar to PDF417 
the data content is divided into rows and columns. Codablock-F is a stacked symbology with 
additional internal checksums for error recognition.  

Codablock-F is based upon the Code 128 symbology – one data row consists of a single Code 128 
barcode, which is extended by a row identifier and a column check sum.  

► Have caution when modifying these adjustments. Always make a test scan in case of doubt!  

 

 
Figure 31: Codablock-F Properties 

7.12.6.1 Code Format 

Code Format  (Enumeration) Description 

Standard Standard format 

GS1/UCC/EAN Special format defined by GS1/UCC/EAN to be used in GS1/UCC/EAN applications. 

Table 15: Codablock-F – Modes 
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7.12.6.2 Rows [2..44] 

The number of rows. The value must be between 2 and 44. 

Default: the number of lines is calculated automatically based on the number of input characters. 

7.12.6.3 Columns [4..62] 

The number of columns (in data words). The value must be between 4 and 62. Start-, stop- and line-
indicator columns are not taken into account. 

Default: the number of columns is calculated automatically based on the number of input characters. 

7.12.6.4 Row Height [mm] 

The height of an individual row in millimeter. If specified, the barcode height will remain locked at the 
specified value. (Modifying the barcode dimensions will only affect the barcode width.) 

Default: the row height is calculated automatically based on the number of input characters. 

7.12.6.5 Separator Height [mm] 

The width of the row separator line in millimeter. 

Default: the line width is equal to the module width (calculated automatically based on the symbol 
size).  

7.12.7 Composite Symbology 

 
Figure 32: Composite Symbology Settings 

Composite components are available for the following barcodes: 

 EAN8 

 EAN13 

 GS1-DataBar / RSS14 

 GS1 DataBar Stacked / RSS14 Stacked 

 GS1 DataBar Stacked Omnidirectional / RSS14 Stacked Omnidirectional 

 GS1 DataBar Truncated / RSS14 Truncated 

 GS1 DataBar Expanded / RSS Expanded 
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 GS1 DataBar Expanded Stacked / RSS Expanded Stacked 

 GS1 DataBar Limited / RSS Limited 

 GS1-128 / UCC/EAN128 

 UPC-A 

 UPC-E 

 

► By default Composite Component Symbologies are disabled.  

7.12.7.1 2D Composite Component 

None Composite Symbologies are disabled. 

Auto Automatically choose CC-A, CC-B or CC-C Symbology depending on the length of the composite data. 

CC-A CC-A is a variant of the MicroPDF417 Symbol with a unique combination of row address patterns (RAP). 
CC-A is the smallest variant of the 2-dimensional composite component. Up to 56 digits of alphanumeric 
data can be coded with 3 to 12 rows and 4 columns. 

CC-B CC-B is a subset of the MicroPDF417 Symbol, which is identified by the code word 920. The encoding 
algorithm chooses CC-B automatically when CC-A has not enough capacity (Auto-mode). CC-B 
encodes up to 338 digits of alphanumeric data in 3 to 12 rows and 2 to 4 columns. 

CC-C The CC-C structure is a PDF417 Symbol, which is identified by the internal code word 920 (920 is the 
first code word after the symbol length indicator). The CC-C structure can be used as a 2 dimensional 
composite component of a UCC/EAN-128 Composite Symbols. It has the largest data capacity of 
EAN.UCC Composite Symbols. It can encode up to 2361 alphanumeric characters in 3 to 30 rows and 
up to 30 Data-Error-checking-Code-Columns. 

7.12.7.2 Segments per Row 

This property adjusts the number of (graphical data) segments per row in the GS1 DataBar 
Expanded Stacked (RSS) Symbol. This parameter influences the width of the barcode. “Default” 
means that each row contains at least 4 segments. 

► This property is only used by the GS1 DataBar Expanded Stacked (RSS) barcode symbol-
ogy. 

7.12.8 DotCode 

 
Figure 33: DotCode Settings 
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7.12.8.1 Format / Format Specifier 

Code Format (Enumeration) Description 

Auto Auto discriminate the format based on the barcode data.  

If the data starts with 2 digits, barcode is in GS1 format, otherwise generic data is assumed. 

Generic Generic data format, which means that data with no special format is used. If barcode data 
starts with 2 digits, FNC1 is automatically inserted at first position. 

GS1 Special format defined by GS1 that is used for encoding Application Identifiers. Barcode 
data must start with 2 digits. 

Industry Supports certain industry formats (FNC1 at the second position). If you choose this option, 
you also have to fill in the field Application Indicator (2 digits or 1 letter). It determines to 
which industry format the input data corresponds. 

Macro 05 Data is surrounded by an [)>Rs05Gs … RsEot envelop. 

Macro 06 Data is surrounded by an [)>Rs06Gs … RsEot envelop. 

Macro 12 Data is surrounded by an [)>Rs12Gs … RsEot envelop. 

Custom Macro Data is surrounded by an [)>Rs … Eot envelop. If you choose this option, you also have 
to fill in the field Application Indicator (2 digits). It determines which envelop ID is to be 
used. Missing digits and control characters (like Gs, Eot, etc.) have to be added by the 
user. 

Reader Programming Format used to program barcode reading devices. 

Table 16: DotCode – Modes 

7.12.8.2 Size Mode - Size 

The combination of the fields Size Mode and Size specifies the number of rows and columns of the 
barcode. The name of the Size field changes in dependence of the size mode. 

Size Mode Size Field Name Description 

Default -- Use the default aspect ratio between number of columns and 
rows. Default value is 3:2. 

Ratio Width/Height Ratio Width/Height Specify the aspect ratio between number of columns and rows. 

Fixed Width Number of Columns Set a fixed number of columns. 

Fixed Height Number of Rows Set a fixed number of rows. 

Table 17: DotCode – Symbol Size 

7.12.8.3 Print Direction 

The generation of a DotCode symbol can be optimized for the print direction of a printer, with the 
moving direction of the printer head understood. This makes sense when a poor printing quality can 
be expected. Otherwise we suggest the user to set this field to Don’t Care. 

► This setting is applied only if neither the number of columns nor the number of rows of the 
symbol is fixed. 

7.12.8.4 Enforce Binary Mode 

Specifies whether to enforce binary encoding. In Binary Encoding mode the encoding algorithm 
does not try to calculate the smallest possible symbol, but it uses binary encoding for all characters. 
This is recommended for binary input data and for barcode generation with optimal speed. 

7.12.8.5 Mask 

Specifies the mask pattern that is applied to the symbol to improve the readability of the code. By 
default the mask is calculated automatically. If you want to accelerate computation time, you can 
either choose Fast calculation mode or a mask value directly. 

Appropriate mask patterns are Mask 0 to Mask 3, and Mask 0 Prime to Mask 3 Prime. Choose the 
Prime Patterns only if your scanner supports DotCode Rev. 4.0 or above. 
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7.12.8.6 Structured Append 

If you want to encode large quantities of data, you can “connect” several DotCode symbols by the 
use of Structured Append. For each DotCode symbol you have to assign a symbol identification 
number which is entered in the field Index of this Symbol. Its value can range from 1 to 35. This index 
indicates the order, in which the data is joined after the reading/scanning process. The total number 
of arranged symbols must be entered in Number of all Symbols. 

7.12.9 Han Xin Code 

 
Figure 34: Han Xin Settings 

7.12.9.1 Symbol Version (Size) 

The version (= size) of the symbol is specified by a version number, the number of rows and the 
number of columns. The range for DotCode symbols is from (1) 23 x 23 up to (84) 189 x 189 modules. 

If the property is set to default, the size is computed automatically based on the data to be encoded. 

7.12.9.2 Enforce Binary Mode 

Specifies whether to enforce binary encoding. In Binary Encoding mode the encoding algorithm 
does not try to calculate the smallest possible symbol, but it uses binary encoding for all characters. 
This is recommended for binary input data and for barcode generation with optimal speed. 

7.12.9.3 Error Correction Level 

Defines the error correction level. You can choose from the following values: 

Error Correction Level  
(Enumeration) 

Description 

L1 Lowest level. Data recovery capacity is up to approximately 8%. 

L2 Up to 15%. 

L3 Up to 23%. 

L4 Highest level. Up to 30%. 

Table 18: QR Code – Error Correction Levels 

7.12.9.4 Mask Pattern 

Specifies the mask pattern that is applied to the symbol to improve the readability of the code. By 
default the mask is calculated automatically but it would make sense to specify this setting directly if 
you have to optimize the computation time. With the values Mask 0 to Mask 3 you choose the 
appropriate mask pattern. 
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8 Data List 

8.1 General 

In order to administrate series of barcode data, you can use the data list feature. 

After performing the barcode settings (chapter 7 Barcode Studio User Interface) you can produce a 
series of barcode images (chapter 8.5 Export) or print barcode labels (chapter 9 Label Printing). 

The data can be  

 imported from a file, 
(chapter 8.3 File Import) 

 generated by a sequence generator, 
(chapter 8.4 Sequence Generator) 

 edited manually by the user, 
(chapter 8.2 Data List View) 

Go to the Data List tab to see the following view: 

8.2 Data List View 

 
Figure 35: Data List View 

The data list  contains a list of barcode data, which can be used for exporting a series of barcode 
images or for printing labels. The data can be inserted, updated or deleted (), imported from a text 
file or generated automatically by a sequence generator (). The image export is done via the button 
. For more information on label printing please go to chapter 9 Label Printing. 

8.2.1 List Content 

8.2.1.1 Generate 

The column “Gen.” (for Generate) determines whether a data row shall be exported or not. This value 
is checked by default. 

8.2.1.2 Status 

The column “Status” informs the user whether a barcode can be created successfully (  – the data 

is valid for the given settings) or not ( ).  











 
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To get a detailed error message select the data row with the error icon. The error message is shown 
in the Barcode View above. 

8.2.1.3 Data 

This column contains the barcode content. This value is mandatory for barcode generation. Values 
can be edited manually, imported from a file or generated with the sequence generator. 

8.2.1.4 Composite Data 

“Composite Data” contains the content of the composite part of a barcode. It is only used in connection 
with composite barcode types. So the column is only visible if a composite barcode type is selected. 
The data can be edited manually or imported from a file. 

8.2.1.5 Captions 

The caption columns contain those texts that are printed above or below the barcode. The columns 
are only visible if the according caption field is activated in the caption tab (on page Barcode). The 
following caption fields are available: Caption Above, Caption Above 2, Caption Below, and 
Caption Below 2. The captions can be edited manually or imported from a file. 

8.2.1.6 File Name 

This column contains the name of the exported file. The file names can be edited manually, imported 
from a file, or generated automatically during export. 

8.2.1.7 Label Count 

Here you can set, how many labels are printed for this data row. This value effect on exporting images. 

8.2.1.8 Exported At 

The column “Exported At” contains the time when the barcode was successfully exported last time. It 
is generated automatically during export and cannot be changed by the user.  

8.2.1.9 Comment 

The user may enter comments for the data list here. 

8.2.2 Symbol Size / Module Width 

By default all barcodes in the data list have the same module width. That means barcodes with 
different contents may vary in size but the minimum bar width (= the module width) and the quality 
will be the same for each barcode.  

The user also has the possibility to generate barcodes with (nearly) the same symbol size (but 
different module width). He can do this by checking the field Lock Symbol Size .  

8.2.3 Order 

You can order the data list by clicking on one of the header columns. With the first click the list will be 
sorted in ascending order by the content of the respective column, when clicking again the order is 
changed to descending. When clicking the button Reset Order  the order is reset. 

The actual order is used for label printing, too. See also chapter 9 Label Printing. 
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8.2.4 Editing 

8.2.4.1 Add New Entries 

The user can append new barcode entries by clicking the button Add. All columns are filled with the 
actual settings from the Barcode page. 

8.2.4.2 Edit the Data List 

The data in the list can be edited directly by mouse click (or by pressing F2). The user may change 
the content of the columns Data, Composite Data, Text Above (1/2), Text Below (1/2), File Name and 
Comment. The column Data is a mandatory field, for all other the input is optional. 

8.2.4.3 Delete Entries 

By clicking the Delete button the user can delete one or more selected data list entries. 

8.2.4.4 Refresh 

The Refresh button updates the error status of the data list entries. 

8.2.4.5 Populate Columns 

If you want to populate a column with a text, choose a single cell, enter the desired value, leave the 
edit mode (by clicking enter), right clicking the cell and choose Populate Column from the popup 
menu. 

8.2.5 Error Status 

 
Figure 36: Error Status 






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The status icons in  inform the user whether the data content of each row is valid for the actual 
barcode settings. 

In order to avoid long update times, the error status is not kept up-to-date. The user has to click 
Refresh  to see the real error status. 

If one or more data rows produce an error, the user is informed about the number of invalid data rows 
through a warning box (see ). 

8.3 File Import 

8.3.1 Import Dialog 

8.3.1.1 File 

Enter or choose the name of the import file in . The file must be a text file with character-separated 
values (*.csv, *.tsv, etc.). The data rows are separated by line breaks and the columns by a specified 
separator character. 

 

 
Figure 37: File Import 

8.3.1.2 File Encoding 

The file import supports 3 kinds of file encodings (): ANSI, UTF-8, and UTF-16. Default for MS 
Windows is ANSI, default for Linux and Mac OS is UTF-8. 

8.3.1.3 Field Separator and Text Qualifier 

The field separator () divides data rows into several columns. Frequently used separator characters 
are comma (,), semicolon (;), and tabulator, but the user can specify any character he likes. 









 





 
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If the import data contains separator characters within a single column, the user has the option to 
specify a text qualifier character (). All characters between two related text qualifiers are handled 
as unit. Often used text qualifiers are quotes (‘) and double quotes (“). If the imported data contains 
text qualifiers, they have to be escaped by either doubling them (““”) or by prepending a backslash 
(\”  “). 

8.3.1.4 Date Format 

To import date fields correctly, the user may choose a date format  which is used in the import file. 
Currently only one date format can be specified. 

8.3.1.5 First Row Contains Column Names 

If the setting  is checked the first row is assumed to contain the column names. 

8.3.1.6 Skip Empty Rows 

Determine whether to skip empty rows in the data file (). 

8.3.1.7 Preview and Status 

As soon a valid file name has been specified the preview  shows the first lines of the import file.  

8.3.2 Data Mapping 

 
Figure 38: Data Mapping 

Analogical to the data assistant when used for editing the data, the input assistant offers a comfortable 
way to import various data formats by choosing a suitable import format . 

In order to import raw data choose the default format. 

Each column of the import file can be mapped to one of the columns Data, Composite Data, File 
Name, Caption Above (1/2) and Caption Below (1/2) in the data list. The selection of a Data column 
is mandatory, for all other columns the assignment is optional. 

If you choose another import format, the fields according to the format are listed below (see below for 
examples). 


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It is recommended to check the field Check the Imported Data in order to keep data consistence as 
high as possible. It should be unchecked only if performance problems occur. 

Below you find examples for importing various data formats. 

Example vCard: 

 
Figure 39: Import Assistant – vCard 
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Example Email: 

 
Figure 40: Import Assistant – Email 
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8.4 Sequence Generator 

  
Figure 41: Sequence Generator 

By clicking Sequence… the user opens the Sequence Dialog with the sequence generator. The 
sequence generator allows the user to fill the data column in the data list with formatted serial 
numbers. 

8.4.1 Start Value / End Value / Increment 

The range of a sequence is specified by the Start Value, the End Value, and the Increment (see ). 
The start value defines the lower bound of the range, the end value the upper bound, and the 
increment the step size between consecutive list items. 

► The last value of the sequence will never exceed the number specified in End Value.  

8.4.2 Mask 

The Mask  defines the pattern, which will be applied to the items of the sequence. The mask string 
may contain 4 kinds of placeholders, which are replaced by the digits of a serial or random number 
during generation. All other characters are left as they are. 

Character Description 

# Barcode Studio inserts leading blanks instead of the placeholders, if the serial number has fewer digits 
than the Format string. 

$ Like “#” but insert leading zeroes instead of blanks. 

* Like “#” but insert leading stars instead of blanks. 

? Each ‘?’ is replaced by a random character (see 8.4.5 Random Value Generation). 

 All other characters are used literally. 








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Table 19: Format – Characters 

Examples for serial numbers: 

Format 
String 

Sample Output Description 

$$ 01, 02, 03, …, 10, 11 Leading zeroes 

##   1,   2,   3, …, 10, 11 Leading spaces 

**  *1, *2,  *3, …, 10, 11 Leading asterisks 

00$$ 0001, 0002, 0003, …, 0099 Like “$$” but with “00” as constant prefix 

A$$ A01, A02, A03, etc. Like “$$” but with “A” as constant prefix 

Table 20: Format – Examples 

► If you enter “$$$” and create a sequence containing numeric values higher than 999, the 
barcode data will be truncated. In this case change the format string. 

8.4.3 Help Button 

With the help button (“?”) you can show and hide a short description of the mask pattern. 

8.4.4 Restrict Serial Numbers to Placeholders 

This flag lets you decide whether the generated serial number is restricted to the number of 
placeholders. If yes the excessing digits in the front are cut off. If not all digits of the serial are shown. 

You can use these flag to generate serial values without leading padding characters. 

8.4.5 Random Value Generation 

If the mask contains at least one ‘?’, random value generation  is enabled. Each ‘?’ is replaced by 
a random value taken from the list of Allowed Characters. 

If you choose Generate unique values, the resulting sequence is checked whether it contains multiple 
identical values. If so an error message is shown when clicking Ok. The user may try again or change 
the sequence parameters to be more successful. 

8.4.6 Preview 

Click Preview to create the sequence based on the settings specified above. The list  shows a 

preview of the generated data. 

Press OK to insert the sequence into the data list. 
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8.5 Export 

 
Figure 42: Export Dialog 

By clicking Export… the Export dialog opens. Here the user can specify a destination directory (), 
a rule for the automatic generation of file names (), and other parameters. 

8.5.1 Export Settings  

8.5.1.1 Destination Path 

The destination path specifies to which directory the export images shall be saved.  

8.5.1.2 File Format 

Specifies the file format of the export file. For a description of the different file formats, please refer to 
Appendix C.  

8.5.1.3 Check the Barcode Data before Export 

If this field is checked, the barcode data is checked before the export. If the data list contains invalid 
data the user will be informed. 

8.5.1.4 Export EPS Files with a TIFF Preview 

If this field is checked, a TIFF preview is added to the generated EPS files. The check box is only 
available if one of the EPS file formats is selected. 










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8.5.2 File Name Generation  

8.5.2.1 File Name Prefix 

The file name prefix is prepended to the generated file name. 

8.5.2.2 File Name 

The user has the possibility to choose between following file name generation methods: 

Generation Method Description 

Same as Data The file name is based on the barcode data (sequence data). For instance if you encode 
“12345” in the barcode, the file name will be prefix + 12345.bmp. This method is ideal for 
numeric barcode data. 

Note: if the sequence data contains characters that are not allowed for file names, please 
use URL-encoding. 

Serial Number The image file names are based on serial numbers starting with 1. The user can specify the 
number of digits for the generated numbers (). 

Table 21: Sequence – File Name 

8.5.2.3 URL-Encoding 

If checked, the file names are URL-encoded. That means that characters that are not allowed in file 
names are escaped by a percent sign followed by the hexadecimal ASCII code. 

Character HEX-Code Character HEX-Code Character HEX-Code 

\ %5C / %2F : %3A 

* %2A ? %3F “ %22 

< %3C > %3E | %7C 

% %25     

8.5.2.4 Keep User Defined File Names 

If checked, the file names, which are already defined in the data list, are kept. If unchecked all file 
names are overwritten by the file generation. 

8.5.3 Preview 

The preview  demonstrates how the generated file names will look like. 

8.5.4 Export 

8.5.4.1 Save as CSV File 

The property  specifies whether the data list shall be exported as CSV file. If enabled the dialog 
Save as CSV File opens after clicking OK (See 8.6 Save as CSV file). 

8.5.4.2 Export Barcodes 

By clicking OK the barcode images are exported. 

If one or more of the image file cannot be generated, an error message will be shown. This may have 
one of the following reasons: 

 An item of the sequence list cannot be encoded with the actual selected barcode type (e.g.: 
The symbology 2of5 IL is used, but the barcode data does not contain only digits, but also 
characters.) 

 An invalid file name has been generated (e.g.: A file name contains a backslash, but the 
option “URL Encode the File Names” was not selected). 
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Keep in mind that exporting many data list items can take a lot of time and hard drive space! 

8.6 Save as CSV file 

The dialog Save as CSV File can be opened either directly via menu. Or by checking Save also as 
CSV File in the Export dialog. 

 
Figure 43: Save as CSV File Dialog 

8.6.1 File 

The destination file name of the export. 

8.6.2 File Encoding 

The export supports 3 kinds of file encodings: ANSI, UTF-8, and UTF-16. Default for MS Windows is 
ANSI, default for Linux and Mac OS is UTF-8. 

8.6.3 Field Separator and Text Qualifier 

The field separator divides data rows into several columns. Frequently used separator characters are 
comma (,), semicolon (;) and tabulator, but the user can specify any character he likes. 

If the export data contains separator characters within a single column, the user has the option to 
specify a text qualifier character. All characters between two related text qualifiers are handled as 
single unit. Often used text qualifiers are quotes (‘) and double quotes (“). If the exported data 
contains text qualifiers, they are escaped by either doubling them (““”) or by prepending a backslash 
(\”  “). 

8.6.4 First Row Contains Column Names 

If the setting is checked the first row contains the column names. 

8.6.5 Save Barcode Image Files with Full Path 

Determine whether to save the barcode image file names with the full export path. 

8.6.6 Barcode Image Path 

The destination path for the barcode images. This path is used to generate the full path names in the 
CSV file. 
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9 Label Printing 

9.1 General 

Barcode Studio offers a simple solution for printing barcodes on labels. Therefore the following steps 
are required: 

 Configure the barcode settings 
(see chapter 7 Barcode Studio User Interface) 

 Generate or import the barcode data 
(see chapter 8 Data List) 

 Choose a suitable label template () or define the labels yourself () 
(see sections 9.2 Templates and 9.3 Settings) 

 Preview the layout () and print your labels () 
(see sections 9.5 Preview and 9.6 Printing) 

 

 
Figure 44: Label Printing 








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9.2 Templates 

 
Figure 45: Label Templates 

9.2.1 Brand 

By selecting a brand the list of label definitions can be filtered. The item [All] displays the complete 
label list. 

9.2.2 Label 

Choose the desired label from the list. 

The settings for the selected label are shown in  (see also section 9.3). These values can be 
adapted manually if required. 

The preview window  shows the label outlines (see also section 9.5). 

9.3 Settings 

Here you can change the label settings. 

 
Figure 46: Label Settings 



 
 
 

Page 68 of 86 

 

Barcode Studio User Manual  

9.3.1 Number of Columns/Rows 

Defines the number of label columns and label rows per page. 

9.3.2 Start Column / Start Row 

Defines the position of the first label to be printed on first page. Label positions before the given 
position are skipped. The effect of this setting depends on the printing order. 

9.3.3 Unit 

Specifies the unit of the label sizes. 

9.3.4 Column Width 

Defines the width of a label.  All labels have the same width. 

9.3.5 Row Height 

Defines the height of a label.  All labels have the same height. 

9.3.6 Column Spacing 

Specifies the horizontal gap between two labels. 

9.3.7 Row Spacing 

Specifies the vertical gap between two labels. 

9.3.8 Print Order 

Defines the order, in which the labels are printed (Down, then Across or Across, then Down). 

9.3.9 Page Setup 

A click on Page Setup… opens the Page Setup dialog. There you can change the page settings, 
including the page margins. 

9.4 Page Setup Dialog 

Here you can specify the page layout. 

 
Figure 47: Page Setup 
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9.4.1 Page Size 

Select either a predefined (A3, A4, Letter, etc.) or custom page size with a given Width and Height. 

9.4.2 Orientation 

Choose the orientation of the paper. It may either be Portrait or Landscape. 

9.4.3 Margins 

Define the page margins from the top, the bottom, the left, and the right side. 

9.5 Preview 

 
Figure 48: Preview 

The label preview consists of a tool bar () and a preview window (). The preview window shows 
the label outlines including the barcodes generated from the data list. 

 
Figure 49: Preview – Settings 

9.5.1 Preview 

The preview gives you an idea how the print-out will look like. The barcodes are generated from the 
data in the data list. The dashed blue lines outline the label shapes. These are shown in the preview 
only, but not on the print-out. 




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Figure 50: Barcode is being clipped 

If the barcode exceeds the size of the label, the label will be marked with a red frame. The user will 
be informed with an appropriate warning message. 

9.5.2 Tool Bar 

The tool bar gives the user the possibility to zoom in or out. Furthermore it allows the user to turn 
pages if the print job consists of multiple pages. 

9.5.3 Settings 

The user specifies whether only the first page or all pages are shown in the preview. 

► The setting Show All Pages can decrease the performance of the preview rendering dra-
matically. Especially for a large number of data rows we recommend the setting Show Only 
First Page. 

9.6 Printing 

 
Figure 51: Print Labels 

9.6.1 Check Before Printing 

If this option is activated all barcodes will be checked before they are printed. If one or more barcodes 
cannot be created or if they are clipped, the user will be notified by an appropriate error message. 
The user may cancel or continue at his risk. 

 
Figure 52: Error Message 

► In order to avoid misprints we highly recommend you to activate this field. 
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9.6.2 Printing… 

By clicking Print… the print dialog is opened. In this dialog you can select the printer, and you can 
specify the page range and the number of copies. The Print button confirms the dialog and starts the 
print job. 
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10 Options 

In the Options dialog you can change general settings for the application. You can open the Options 
dialog via the menu Tools ► Options…   

The settings in this dialog are saved into the file bcstudio.bcopt, which is located in the Application 
Data/Program Data directory (e.g., C:\ProgramData\TEC-IT\BCStudio\16.4\examples). They are 
loaded automatically each time Barcode Studio is started. 

  
Figure 53: Options Dialog 

10.1 Barcode Export 

10.1.1  Default File Name 

The user may choose which file name is proposed for barcode export. Possible values are Last used 
name and Like data. 

10.2 EPS Export 

10.2.1 Add Preview (TIFF) 

Many applications are not able to process Postscript. In this case the embedded EPS documents are 
displayed as placeholders only (e.g., empty rectangles). To give the user a chance to see the content 
of the embedded document in the preview or in the design mode, the EPS generator offers the 
possibility to add a TIFF preview image to the EPS file. 

The preview in TIFF format is supported by many applications (unfortunately not by all). 

► If the preview mode is enabled, the size of the generated EPS files grows by a multiple of 
the original file size. So the preview mode should be disabled for printing a large number of 
documents. 


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10.2.2 Font Substitution 

Font Substitution is only used when exporting the barcode to an EPS file. This is an advanced option 
and should only be changed for special applications. 

Font Substitution Description 

None The font will not be substituted, unless it is invalid. 

Automatic (Default) The font will always be substituted with an appropriate one. 

Fixed Font The font will always be substituted with the font specified in “Surrogate Font” 

Table 22: Font Substitution 

10.2.3 Surrogate Font 

Specifies the font for EPS exports. This property overrides the “Font” property on the “General” tab, 
but only if “Font Substitution” () is set to “Fixed Font”. 

Please note that you have to specify the “internal font name” (may not contain any spaces). 

10.3 Templates 

10.3.1 Template Directory 

All template files (*.bc), which are listed in the template tree in the main window, are read from this 
directory. The template directory path is preset by the setup routine, but it may be changed afterwards 
if required (e.g., if the user wants to use a custom set of templates). 
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11 FAQ 

► For more information on the barcodes and their parameters, please check out the TEC-IT 
Barcode Reference on www.tec-it.com/download/PDF/Barcode_Reference_EN.pdf 

► More Information can be found on our website  
www.tec-it.com/support/faq/Default.aspx 

► In case of problems, please contact our support team: support@tec-it.com. 

11.1 How can I encode the FNC1 character in EAN128? 

Enable the option “Escape Sequences” (page Settings) and insert the following escape code into the 
data: 

Control character Escape sequence Barcode type(s) 

FNC1 \F Code 128, EAN128, UCC128, GS1-128, GS1-DataBar 

EAN.UCC Composite Symbology 

Read more about Application Identifiers (EAN/UCC/GS1) in our Barcode Reference. 

11.2 How can I encode the FNC1 character in GS1/UCC/EAN Data Matrix? 

Set the “Code Format” (page Data Matrix) to GS1/UCC/EAN, enable the option “Escape Sequences” 
(page Settings) and insert the following escape code into the data: 

Control character Escape sequence Barcode type(s) 

FNC1 \F EAN Data Matrix 

Read more about Application Identifiers (EAN/UCC/GS1) in our Barcode Reference. 

11.3 Escape-Sequences are not encoded (and the scanner signals an error) 

Escape sequences are used for encoding special characters. An escape sequences consists of a 
backslash “\” followed by a character or a hex value. For example, the escape sequence “\t” is used 
for printing a tabulator character. 

Escape sequences are only translated if the checkbox “Escape Sequences” (page Settings) is 
enabled (see section 7.8.1.1)! 

11.4 After saving the barcode to an image file, my barcode scanner cannot 
read the barcode! 

The bars and spaces in the symbol must have precise widths. By creating a bitmap image from the 
barcode, the widths are adapted to the matrix of the bitmap. Depending on its resolution more or less 
deviations can occur. The lower the resolution, the more differences in the width of the bars/spaces 
will usually appear. 

There are different strategies to overcome these problems – please check out the section “Resolution 
and Readability” in the Barcode Reference for more information. 

https://www.tec-it.com/download/PDF/Barcode_Reference_EN.pdf
https://www.tec-it.com/support/faq/Default.aspx
mailto:support@tec-it.com
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11.5 What are the required steps to print labels on my thermal label printer? 

The steps for setup Barcode Studio for thermal label printing are as following: 

 Adjust the label size correctly in the Windows printer driver (most important step) 

 Set your label printer as the default printer (under Windows1), otherwise the label size is not 
recognized correctly. 

 Open Barcode Studio and change to the Labels tab, adjust the following label settings 

 

 The column width and row height you enter must match the label size 

 Open the print menu and click Preferences and verify the label size + click Apply 

 Click the Page Setup button (see screenshot above) 

 Select the label size you have adjusted in the printer driver – if it is a custom size you should 
see “Custom” 

 After that the preview should change and you see one bar code on one label only. 

                                                                 
1 Under macOS® the first printer in the list is your default printer 
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12 Licensing 

12.1 License Types 

Please check out www.tec-it.com/order/Default.aspx for available license types and pricing. 

12.2 Entering your License Data 

To enter the license data select Help ► License… from the menu. The dialog below will appear. 
Barcode Studio provides two methods for entering the license data: 

 Online Activation using the Activation Key (see 12.2.1). 
This is the default method. Internet access is required. 

 Manual Licensing (see 12.2.2). 
Please get in touch with us if your system has no internet access or if you prefer to use the 
manual activation for any other reason. We will be glad to send you the license data which is 
suitable for manual licensing. 

12.2.1 Online Activation using an Activation Key 

If you have received an activation key from TEC-IT, please use the online product activation . 

Internet access is required. 

 
Figure 54: License Dialog – Online Activation 

1. In field  enter the activation key. 

2. In field  enter your email address. A license certificate will be sent to this address 
automatically. 

3. Complete all remaining data (Company, Country, ZIP Code, and City). For a successful 
activation all fields are required. 

4. Confirm the entered data by agreeing to the privacy policy and clicking Send. 

A message will inform you about the successful activation. In case of problems or errors, please 
contact TEC-IT. 







https://www.tec-it.com/order/Default.aspx
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12.2.2 Manual Licensing 

Manual licensing is the alternative method for licensing if your system has no internet connection. 
Select manual licensing  and enter the license data as provided by TEC-IT. 

► Please enter the license data exactly as you received it from TEC-IT!  
Spacing and upper/lower case letters are to be considered. To avoid typographical errors, 
please insert the data using “copy and paste” from the email containing your license data 
whenever possible.  

► Single licenses   
If you purchased a single (workstation) license, you need to provide the so-called "System ID” 
(or hostname on LINUX and MAC) of the target computer. You can find the System ID (or 
hostname) in the licensing dialog (see below). 

 

 
Figure 55: License Dialog – Manual Licensing 

The following steps are required to license the product: 

1. On the top of the dialog you find the System ID2 () of your computer. 
For single licenses we will ask you to send us the System ID of the target computer. 

2. In the field "Product” please choose between “Barcode Studio 1D (Linear Codes)” and 
“Barcode Studio 2D (1D + 2D Codes)”. 

3. In the field "Licensee” enter the name of the license holder. 

4. In the field "Kind of License” select the kind of license that you have purchased. Possible 
license types are: 

­ Single 
­ Site 
­ Enterprise 

5. In the field "Number of Licenses” enter the number of licenses that you have purchased. 

6. In the field "Your License-Key”, enter the license key exactly as received from TEC-IT. 

7. Confirm the dialog with OK. 

A message will inform you about the successful activation. In case of problems or errors, please 
contact TEC-IT. 

                                                                 
2 On UNIX, Linux or Mac OS X the hostname of the system is used as System ID (relevant only for Single licenses) 



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12.3 Temporary Test Licenses 

For a restricted period of currently 10 days, you have the possibility to gain a temporary, but otherwise 
unrestricted test license for one time. 

When opening Barcode Studio you see a dialog, which allows you to request a test license online. 

 
Figure 56: Request Test License 

Please click the button YES. The license data is transmitted automatically. In the case of an error 
please contact TEC-IT. 

 
Figure 57: Demo Version Unlocked 

If you have received the test license successfully, you are informed about the remaining test period 
with every application start. 
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12.4 Refresh your License 

Some kinds of licenses allow a license update via Barcode Studio (e.g. from version 15 to version 
16). This is either done automatically after program start or triggered via the menu item Help ► 
Refresh License…. 

If the license update was successful, you are informed by a dialog. 

 
Figure 58: Successful License Update 
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13 Contact and Support Information 

 
TEC-IT Datenverarbeitung GmbH 
 

Address: Hans-Wagner-Str. 6  

AT-4400 Steyr  

Austria/Europe 

Phone: +43 / (0)7252 / 72 72 0 

Fax: +43 / (0)7252 / 72 72 0 – 77 

Email: office@tec-it.com 

Web: www.tec-it.com 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

AIX® is a registered trademark of IBM Corporation.  
HTML, DHTML, XML, XHTML are trademarks or registered trademarks of W3C, World Wide Web Consortium, Laboratory for Computer 
Science NE43-358, Massachusetts Institute of Technology, 545 Technology Square, Cambridge, MA 02139.  
JAVA® is a registered trademark of Sun Microsystems, Inc., 901 San Antonio Road, Palo Alto, CA 94303 USA.  
JAVASCRIPT® is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by 
Netscape.  
Linux® is a registered trademark of Linus Torvalds in several countries. 
UNIX® is a registered trademark of The Open Group 
Microsoft®, Windows®, Microsoft Word®, Microsoft Excel® are registered trademarks of Microsoft Corporation.  
Navision is a registered trademark of Microsoft Business Solutions ApS in the United States and/or other countries. 
Oracle® is a registered trademark of Oracle Corporation. 
PCL® is a registered trademark of the Hewlett-Packard Company. 
PostScript® is a registered trademark of Adobe Systems Inc. 
QR Code® is a registered trademark of DENSO WAVE INCORPORATED in the United States and other countries. 
SAP, SAP Logo, R/2, R/3, mySAP, ABAP, and SAPscript are trademarks or registered trademarks of SAP AG in Germany (and in several 
other countries).  
SPARQCODE is a trademark of MSKYNET, INC. 
 
 
All other products mentioned are trademarks or registered trademarks of their respective companies. If any trademark on our web site or in this 
document is not marked as trademark (or registered trademark), we ask you to send us a short message (office@tec-it.com). 

mailto:office@tec-it.com
https://www.tec-it.com/
http://www.trademarkia.com/company-mskynet-inc-1384812-page-1-2
mailto:office@tec-it.com
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Appendix A: Barcodes 

A.1 Supported Barcodes 

Please refer to the additional document “Barcode Reference” available from www.tec-it.com. 

This document contains an overview of the supported barcodes, enumeration values (for developers 
using TBarCode OCX), the standard print ratio and the standard check digit methods. 

A.1.1 MaxiCode 

13.1.1.1 Setting SCM parameters 

Please refer to the additional “Barcode Reference” available from www.tec-it.com. 

A.2 Check Digits 

The method for the check digit(s) calculation depends on the respective barcode type. A standard 
method for each barcode type is supplied. 

See section 7.8.1.1 for adjusting the check digit in Barcode Studio. 

For more information please refer to the “Barcode Reference” available at www.tec-it.com. 

A.3 Print Ratio 

The Print Ratio is the relationship between the widths of the bars and the widths of the gaps of a 
barcode. Each barcode symbology should be generated with certain print ratios only. 

See section 7.8.2.1 for adjusting the print ratio in Barcode Studio. 

For more information please refer to the “Barcode Reference” available at www.tec-it.com. 

A.4 Format 

Format is like a "mask”, which is used for formatting the barcode data before encoding (please do not 
mix up the Format with the Ratio Format). Placeholders in the specified format string can be mixed 
with constant data characters to build a final barcode data string. Also control characters are 
supported. 

See section 7.8.3.1 for adjusting the format string in Barcode Studio. 

For more information please refer to the “Barcode Reference” available at www.tec-it.com. 

A.5 Escape Sequences 

If you want to encode non-printable or special characters in a barcode, “Escape Sequences” must be 
used. They always start with a backslash (“\”) followed by the sequence. They can be used for 
encoding binary data (Bytes) too (if the symbology you are using offers this feature – e.g. PDF417 or 
Data Matrix). 

See section 7.8.1.3 for enabling or disabling the translation of escape sequences in Barcode Studio. 

For more information please refer to the “Barcode Reference” available at www.tec-it.com. 

https://www.tec-it.com/
https://www.tec-it.com/
https://www.tec-it.com/
https://www.tec-it.com/
https://www.tec-it.com/
https://www.tec-it.com/
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Appendix B: Error Messages 

Error Recommended Action 

Wrong character 'x' at position y! You entered a character which cannot be encoded with the selected 
barcode symbology. Please use different barcode symbology or change 
your input data. 

Wrong character 'x' at position y in the 
Format string! 

You entered a character to the format string which is no valid Format 
command and cannot be encoded with the selected barcode symbology. 
Please change or remove the invalid character from the Format string or 
use another symbology. 

Wrong check digit 'x' at position y! You entered a check digit which is incorrect for the selected barcode 
symbology. Please correct the check digit or remove it, so the 
application will calculate it automatically. 

Wrong number of input characters (needs x 
chars)! 

You entered too many or too few characters for the selected barcode 
symbology. Please use another symbology or correct the length of the 
input data. 

Input string too long The input string is too long for Barcode Studio. Please reduce the 
length of the input data. 

Barcode does not fit into bounding rectangle The output resolution is too small to produce a readable barcode with 
given symbol size. You either have to increase the width/height of the 
barcode, the module width, or the output resolution. 

No input characters No barcode data is specified. Please enter some data in the Barcode 
Data field. 

Invalid code page or invalid characters! You entered characters which cannot be encoded in the selected code 
page. Please use a different code page or change the input data. 

Not implemented (reserved for future use) The selected barcode symbology is not supported yet. Please contact 
TEC-IT for an implementation request. 

Invalid data format. Please examine the 
specification 

The input data are not suitable to the definition of given barcode type. 
Please examine the specification of the barcode type about the required 
data format. 

This error message is shown mainly if a detailed error description would 
exceed the available space. 

Quiet zone too small for vertical bearer bars You chose bearer bars of type Rectangle. This setting needs a 
horizontal quiet zone of sufficient size. Please increment the left and the 
right quiet zone to at least 12 modules. 

Error in linear Component: … You want to generate a composite symbology. The data for the linear 
symbol is incorrect. The following error message describes the problem 
more detailed. 

Error in 2D Composite Component: … You want to generate a composite symbology. The data for the 2D 
component is incorrect. The following error message describes the 
problem more detailed. 

Invalid number of input characters in 
combination with composite! 

When using UCC/EAN-128 as part of a composite symbology you have 
to enter a minimum amount of symbol characters (which is not equal to 
the amount of input characters). Please increase the number of input 
characters in the Barcode Data field. 

Table 23: Error Descriptions 
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Appendix C: Image Types 

Choosing Export ► Export Barcode… the barcode can be converted to a bitmap or image format. 
The following image types are available. Please keep in mind that the barcode might get unreadable 
if the resolution of the generated bitmap is too low (does not apply for vector based image formats). 

Image 
Format Description 

Internal 
Format Color 

Printing 
Resolution 
included? 

BMP Microsoft Windows Bitmap. Bitmap color (RGB) Yes 

AI Adobe Illustrator v7 

Offers the following sub-formats: 

 CMYK 
uses CMYK color space (4 color channels). 

 RGB 
uses RGB color space (3 color channels). 

 Grayscale 
uses one channel (luminance) only. 

Vector color 
(CMYK, 
RGB) 
or grayscale 

 

EPS Encapsulated PostScript. 

Offers the following sub-formats: 

 CMYK 
 RGB 
 Grayscale 
See AI format. 
Please note that the EPS export may require additional font 
adjustments (see section 10.2.2). 
Color overprinting is supported. 

Vector color 
(CMYK, 
RGB) 
or grayscale 

No 

GIF Graphics Interchange Format. Supported since Barcode Studio 
V7. Not supported in previous versions because of license terms.  

Bitmap color (RGB) No 

JPG Joint Photographic Expert Group image file format. Bitmap color (RGB) Yes 

PDF Portable Data Format. 

Offers the following sub-formats: 

 CMYK 
 RGB 

See AI format. 

Color overprinting is supported. 

Vector color 
(CMYK, 
RGB) 

No 

PNG Portable Network Graphics. Bitmap color (RGB) Yes 

SVG Scalable Vector Graphics Vector color (RGB) No 

TIF Tagged Image File. No compression is used (compressed 
formats available on request). 

Bitmap color (RGB) Yes 

Table 24: Image Formats 
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Appendix D: Command Line Parameters 

Barcode Studio can also be started from the command line. It supports various parameters which 
allow the user to automate the barcode generation process. 

D.1 Syntax 

1) BCStudio -d=<data> -out=<outputfile> 

            [[-s=]<settingsfile>] [barcode options] [image options] [remaining options] 

2) BCStudio -datafile=<datafile> -out=<outputfile> 

            [[-s=]<settingsfile>] [barcode options] [image options] [remaining options] 

3) BCStudio -datalist=<datalistfile> -outlist=<outputlistfile> 

            [-skipheader=<numlines>] [-parseempty] 

            [[-s=]<settingsfile>] [barcode options] [image options] [remaining options] 

4) BCStudio -datalist=<datalistfile> -out=<outputfile> 

            [-skipheader=<numlines>] [-parseempty] 

            [[-s=]<settingsfile>] [barcode options] [image options] [remaining options] 

5) BCStudio <settingsfile> 

6) BCStudio -g [-d=<data> | -datafile=<datafile>] 

            [[-s=]<settingsfile>] [barcode options] 

7) BCStudio [-? | -help] 

The Barcode Generation Arguments 

-d=<data> Pass the barcode data directly via command line. Is used alternatively to  
-datafile=<datafile> and -datalist=<datalistfile>. 

-datafile=<datafile> Pass the barcode data via data file. Is used alternatively to ˗d=<data> and 
˗datalist=<datalistfile>. 

-datalist=<datalistfile> Pass a list of barcode data via a data list file separated by line breaks. Is used 
alternatively to -d=<data> and -datafile=<datafile>. You can use -datalist together 
with: 

 ˗outlist: each barcode is generated into a separate output file. The number of 
entries in data and output list should be equal. 

 ˗out: all barcodes are generated into a single output file (PDF only). 

Exception: If output list file only contains one file name, all barcodes are exported to 
this file (equivalent to parameter ˗out, PDF only). 

-out=<outputfile> The name of the output file (image file). The filename extension may be one of the 
following: JPG, GIF, TIF, BMP, PNG, EPS, AI, SVG, and PDF. The filename 
extension must be specified! Can be used alternatively to ˗outlist=<outputlistfile>. 

-outlist=<outputlistfile> The output list file name. It contains the list of output file names, separated by line 
breaks. Can be used alternatively to -out=<outputfile>. If this argument is used, you 
must also specify -datalist=<datalistfile>. The number of entries in both lists should 
be equal. 

-skipheader=<numlines> Specifies the number of lines on top of the date list file that should be handled as 
header and therefore be skipped. This argument can only be used in conjunction with 
˗datalist=<datalistfile>. 

-parseempty If set, empty lines are handled as data lines, otherwise they are skipped. This 
argument can only be used in conjunction with ˗datalist=<datalistfile>. 

[-s=]<settingsfile> Settings-Files are *.bc files which have been created by Barcode Studio. You can 
override values of the settings file by passing command line arguments. 

If you pass only the settings file without an argument name and no further argument, 
the application is opened in graphics mode. 

-g Start the application in graphics mode. This setting is needed to pass arguments to 
Barcode Studio and start it in graphics mode, though. 

-? 
-help 

Display the help screen. 
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The Barcode Options  

[-w=<width> |-m=<modulewidth>] [-h=<height>] [-u=<unit>] [-o] [-rot=<rotation>] 

-w=<width> 
-m=<modulewidth> 

Specify either the total width of the symbol or the module width (dimension X or 
narrow bar width); given in units (default: µm). 

E.g.: -w=50250 … barcode is 50.25 mm wide 

-h=<height> Height of symbol, given in units (default: µm) 

-u=<unit> The measure unit used for the barcode sizes (width, height, and module width). 
Possible values:  

 MICM (Micrometer) 
 MM (Millimeter) 
 MIL (Mils) 
 IN (Inch) 
 PX (Pixel) 
 PT (Point) 

See also usage dialog. 

-o Optimal resolution: adapt module width to an integral pixel width. Recommended for 
low resolution devices. 

-rot=<rotation> The barcode rotation in degrees. Valid values are 0, 90, 180, and 270. 
(Default = 0). 

 

The Image Options 

[-it=<imagetype>] [-cs=<colorspace>] [-op] [-r=<dpi>] 

[-spotfg=<spot_color>] [-spotbg=<spot_color>] [-spottxt=<spot_color>] 

-it=<imagetype> The image type. The image types are equal to the file extensions. 

-cs=<colorspace> The color space to be used to generate the output file. If not set, the default color 
space of the image type is used (EPS, AI, and PDF only). 

See also usage dialog. 

-op Activates color overprinting (EPS and PDF only). 

-r=<dpi> The resolution of the output file in dpi (default = 600 dpi). 

[-spotfg=<spot_color>] Override the foreground color with a spot color (PDF only). 

See also usage dialog. 

-spotbg=<spot_color> Override the background color with a spot color (PDF only). 

See also usage dialog. 

-spottxt=<spot_color> Override the text color with a spot color (PDF only). 

See also usage dialog. 

 

The Remaining Options 

[-logformat=<logformat>] [-log=<logfile>] [-q] [-fs=<fileseparator>] 

-logformat=<logformat> The log file format. Allowed formats: TEXT, JSON. (Default = TEXT). 

-log=<logfile> The name of the log file. If this argument is not set, no log file is generated. 

-q  Activate the “Quiet Mode”. The program does not interact with the user.  

If an error occurs, a message is logged to file error.log. 

-fs=<fileseparator> A custom file separator, that can be used for separating file names of command line 
arguments and for the list of file names in the output file names list. 
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D.2 Examples 

Generate Code128 (default), content=98765, size 50x30mm: 

bcstudio -d="98765" -out=barcode.bmp -w=50000 -h=30000 -o 

Generate a barcode image (JPG) with 300 dpi and 0.330 mm module width: 

bcstudio -d="12345" -out=barcode.jpg -h=30000 -m=330 -r=300 

Generate a barcode (symbology defined in bc file) 70x30mm: 

bcstudio -d="123" -out="c:\pictures\bc.jpg" -s=bcsettings.bc -w=70000 -h=30000 -o 

Generate a barcode with data from txt file: 

bcstudio -datafile=data.txt -out=barcode.tif -s=bcsettings.bc -w=70000 -h=30000 -o 

Generate a list of barcodes using the arguments datalist and outlist: 

bcstudio -datalist=datalist.txt -outlist=outputfilenames.txt -s=bcsettings.bc -o 

Generate a barcode with optimized readability and fixed module width: 

bcstudio -d="ABCDE" -out=barcode.bmp -s=bcsettings.bc -h=30000 -m=265 -o 

Open a settings file in graphics mode: 

bcstudio bcsettings.bc 

  or 

bcstudio –g -s=bcsettings.bc 

Opens a settings file in graphics mode with given width and height: 50x30mm: 

bcstudio –g -s=bcsettings.bc -w=50000 -h=30000 –u=MICM 


